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Introduction  

Paragon Partition Manager™ 9.0 is an integrated set of powerful tools that is specially designed to tackle 

most of the problems the user might face while using PC. A highly intelligent program engine together with 

built-in advanced recovery facilities make it possible to securely carry out partitioning operations of any 

complexity, optimize performance of NTFS and FAT file systems, migrate the system to another hard disk, 

etc. without fear to lose precious data. The key features of the program are listed in the special chapter. 

 

Setting up major operations is accomplished by using practical wizards. Each step of the wizard includes in-

depth information in order to allow the user to make the right choice. Graphical representations of the data 

help the user to gain a better understanding. 

 

In this manual you will find the answers to many of the technical questions, which might arise while using 

the program. 
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Partition Manager Editions 

The product is being released in several editions, Personal, Professional, Server and Enterprise Server 

which vary in price and provided functionality: 

 

Personal Edition Peculiarities 

 

 The Personal edition does not support dynamic disks: 

- It cannot perform any operations on dynamic disks, but entire deletion; 

- It cannot convert dynamic disks back to basic; 

- However, it can recognize the layout of dynamic disks. 

 Backup to a Network Drive and Perform Incremental Copy functions are unavailable in the Personal 

edition. 

 There is no File Transfer Wizard in the Personal edition. 

 Change Cluster Size, Change Root Size (FAT16), Change Boot Size (FAT16/FAT32), Downgrade 

NTFS Version, Defragment MFT, Compact MFT, Change Primary Slots, Change Serial Number, 

Change Partition ID, Change SID, Convert to Basic program’s dialogs are unavailable in the Personal 

edition. 

 There is no possibility to send notifications by e-mail on the carried out operations in the Personal 

edition. 

 

Enterprise Server Edition Peculiarities 

 

 Only the Enterprise Server edition supports scripting, i.e. it provides the possibility to perform batch 

tasks in the unattended mode. 

 Only the Enterprise Server edition enables to schedule tasks for later execution. 

 Only the Enterprise Server edition offers an advanced backup functionality. 

 Only the Enterprise Server edition allows the user to restore a partition/hard disk directly under 

Windows. 

 Only the Enterprise Server edition provides support of the Microsoft VSS (Volume Shadow Copy 

Service) technology. 

 

Supported Operating Systems 

 

OS Personal Professional Server 
Enterprise 

Server 

Windows 95 No No No No 

Windows 98 Yes Yes No No 

Windows Me No No No No 

Windows NT Yes Yes Yes Yes 

Windows NT Server Family No No Yes Yes 

Windows 2000 Professional Yes Yes Yes Yes 

Windows XP Home Edition Yes Yes Yes Yes 

Windows XP Professional Yes Yes Yes Yes 

Windows XP Professional 64-bit Yes Yes Yes Yes 

Windows 2000 Server Family No No Yes Yes 

Windows Storage Server 2003  No No Yes Yes 

Windows Server 2003 Web No No Yes Yes 
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Windows Server 2003 Standard/ 64-bit No No Yes Yes 

Windows Server 2003 Enterprise/ 64-bit/ Itanium  No No Yes Yes 

Windows Server 2003 Datacenter/ 64-bit/ Itanium No No Yes Yes 

Windows Small Business Server 2003 Standard/ 
Premium 

No No Yes Yes 

Windows Vista Yes Yes Yes Yes 

Windows Vista 64-bit Yes Yes Yes Yes 

 

 

Please take into consideration the mentioned above peculiarities of the certain versions when 

working with the program. 
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Product Components 

In order to cope with different tasks, the product contains several components: 

 

 Windows based set of utilities is the crucial part of the product. With the help of an easy to use 

launcher the user may find and run tasks in the field of hard disk partitioning and optimization, data 

and system backup, hard disk/partition cloning, etc. 

 Linux/DOS based Recovery CD is a multi-platform bootable media that enables to run utilities 

under Linux or PTS DOS, and that way to get access to the hard disk for maintenance or recovery 

purposes. Both platforms have their strong sides, for instance Linux can boast support of FireWire 

(i.e. IEEE1394) or USB devices. It enables to burn CD/DVD disks. However there can be some 

difficulties with detecting new hardware. DOS in its turn has no problems of that kind but is limited 

in features. The Linux/DOS Recovery CD requires no installation and can be of great help when the 

system fails to boot. Besides it offers a Windows XP like environment. 

 WinPE based Recovery CD. Especially for keen followers of Windows, our product also offers a 

WinPE based bootable media. Unlike Linux/DOS Recovery CD it can boast an excellent hardware 

support and the same interface as for the Windows version. However its system requirements are 

much tougher. 
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Features Overview 

This chapter dwells upon key benefits and technical highlights of the product. 

Key Features  

Let us list some of the key features:  

 

 User friendly interface. Easily understood icons accompany all functions of the program. 

 Previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual operations). 

 Basic functions for initializing, partitioning and formatting hard disks. Instead of the standard 

Windows disk tools, the program supports all file systems. 

 Carrying out advanced partitioning operations such as redistribution of available disk space or 

merging of adjacent partitions of NTFS, FAT or FAT32 file systems with the help of easy-to-

use wizards. 

 Boot Manager Setup Wizard to easily manage several operating systems on one computer. 

 Hot Resize NTFS upward allows the user to enlarge NTFS partitions (system, locked) without 

rebooting Windows and interrupting its work. 

 Conversion of FAT and NTFS file systems without reformatting. 

 Install New OS Wizard to make your system ready to install a new operating system. 

 Effective tools for file system optimization. Defragmentation of FAT and NTFS file systems 

will help improve the hard disk performance while working with these systems. 

 Copy Partition/Hard Disk Wizards that enable to successfully transfer all on-disk information 

including standard bootstrap code and other system service structures, thus maintaining the 

operating system’s working capability. 

 Back up a partition/hard disk including service data of the file system. The program supports 

all five types of dynamic volumes (simple, spanned, striped, mirrored, RAID-5). 

 Restore an entire disk or separate files from the disk archive (image). 

 Restore with Shrink function provides the possibility to restore a backup image to a free block 

of smaller size taking into account only the amount of actual data of the image. 

 Recovering of any accidentally deleted partition by using the Undelete Partitions Wizard. 

 Schedule the operation. The user can set a convenient time for the program to perform the 

operation automatically. 

 File Transfer Wizard assists the user with copying of separate files/directories or burning of 

them to CD/DVD. Besides it provides access to Paragon backups as regular folders to browse 

through their contents or copy required files. 

 Shutdown After Apply function enables to set the computer to automatically switch off on the 

successful accomplishment of any operation. 

 Volume Explorer utility allows the user to browse and export contents of the local 

mounted/unmounted volumes of any file system as well as Paragon backups. 

 Build external recovery media that help the user to restore the system even when the current 

operating system cannot boot anymore. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Supported Technologies 
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Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

 

 Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ 

family operating systems providing both high operating efficiency as well as low hardware 

requirements. 

 Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, 

power outages or an operating system failure. 

 Paragon UFSD ™ technology to browse partitions of any file system including hidden and 

unmounted, modify and copy files and folders, etc. 

 Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting 

Windows and interrupting its work. 

 Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller size 

taking into account only the amount of actual data of the image. 

 Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any 

complexity. 

 Paragon BTE ™ technology to set tasks for execution in the Windows blue screen mode, thus saving 

from the need to use a bootable media when modifying system partitions. 

 Paragon Shutdown After Apply™ technology to set the computer to automatically switch off on the 

successful accomplishment of any operation. 

 Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management 

flexibility without the partition limitation of basic disks. Dynamic storage can be particularly 

beneficial for large-scale businesses when dealing with many physical hard disks involving complex 

setup. 

Supported File Systems 

Paragon Partition Manager 9.0 provides support of major file systems presented on the market today: 

 

 Full read/write access to Ext2FS/Ext3FS partitions under all versions of Windows, DOS 5.0 and later. 

 Full read/write access to NTFS (Basic and all five types of Dynamic Disks) under Windows 

95/98/ME, Linux and PTS DOS. Compressed NTFS files are also supported. 

 Basic partitioning operations (create, format, delete) for Linux Swap. 

Supported Media 

 Large hard disks (up to 1,5 TB tested, 2 TB limit in theory) 

 IDE, SCSI and SATA hard disks 

 CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW and also DVD-R, DVD+R double layer 

discs 

 FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks, ZIP® and Jazz® disks, MBR Flash Cards 

 PC card storage devices (MBR flash memory, etc.) 
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Getting Started 

In this chapter you will find all the information necessary to get the product ready to use. 

Distribution 

Paragon Partition Manager 9.0 is distributed in two ways: 

 

 Boxed package from Paragon Technology GmbH and resellers 

 Downloadable package over the Internet at the company’s web-site 

Distributive CD 

The boxed package includes a distributive CD that is in fact a bootable Recovery CD with auto-run of the 

Windows installation, thus it can be used as a ready-made solution (see Booting from the Linux/DOS 

Recovery CD).  

 

Thus in order to run the Windows components, you need to install them first (see Installing the Program). 

 

If you want to download an update/upgrade of the product, it will be in form of the downloadable 

installation package as described in Online Distribution). 

Online Distribution 

Partition Manager 9.0 purchased over the Internet contains two downloadable files: 

 

 Self-extracting file for Windows components installation; 

 Recovery CD ISO image-file with a built-in tool for CD/DVD burning 

 

These files can be downloaded individually as found necessary. 

 

To burn an ISO image of the Recovery CD, simply do the following: 

 

1. Launch the Unpack & Burn Wizard by clicking on the downloaded executable file; 

2. On the Destination page of the wizard select the CD/DVD option to write directly to a CD/DVD 

disk; 

 

 
 

 
The File option enables just to save the image as an ISO file in the required location. 

 

3. On the CD/DVD Writing Parameters page choose the required recording device from the list of all 

available devices, then define the writing options (speed and whether to eject the recorded disc after 

completing the operation or not); 
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4. Insert a blank disk into the recording CD/DVD drive and click the Next button to start the 

operation. 

Registration 

Paragon Technology GmbH provides a wide range of online services through its web-service - KB 

(Knowledge Base): 

 

 Registration of new users; 

 Registration of purchased products for registered users; 

 Available around-the-clock downloading center, where registered users can get product 

updates/upgrades as well as all the necessary documentation; 

 Downloadable free demo versions and open documentation for all users. 

 

To enter the Knowledge Base, please visit the web-site: http://kb.paragon-software.com/. 

 

 
It is recommended to use Internet Explorer 5+ or any compatible browser. 

 

To Register as a New User 

 

To register as a new user, simply do the following: 

 

1. Run the Internet browser and visit the page: http://kb.paragon-software.com/; 

2. Select Registration in the menu; 

3. On the renewed page, select your country and language; 

4. Fill out the registration form.  

 

 

The most important field in the form is an E-mail address, as it serves as a login to enter the 

system. Besides your access password will be sent to this address as well. 

 

To Register a New Product 

 

If you are a registered user and would like to register Partition Manager 9.0, simply do the following: 

 

1. Click Login in the menu; 

2. On the Login page, in the User Name field, enter an E-mail, which you have used for registration;  

3. In the Password field enter the password you received with registration confirmation. Click the 

Submit button; 

4. If the user name and password are valid, you will enter the system; 

5. In the opened menu click the Product Registration item to see a list of all registered products with a 

new registration form; 

http://kb.paragon-software.com/
http://kb.paragon-software.com/
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6. Select Paragon Partition Manager 9.0 from the list of products; 

7. Type in your product serial number in the Serial Number field. Click the Submit button. 

 

That is all. You will receive a confirmation by E-mail. 

How to Download Updates/Upgrades 

Downloading of updates/upgrades can be fulfilled in the following way: 

 

1. Enter the Paragon Software web-service; 

2. In the menu click the Download Update to see what updates are available for you; 

3. Select the desired update and click the Download button. 

Contacting Paragon Technology GmbH 

If you have any questions about the company products, please do not hesitate to contact Paragon 

Technology GmbH. 

 

Service Contact 

Visit Paragon GmbH web 

site 
www.paragon-software.com 

Registration & updates 

web-service 
kb.paragon-software.com 

Knowledge Base & 

Technical Support 
kb.paragon-software.com 

Pre-sale information sales@paragon-software.com 

System Requirements 

Windows based set of utilities 

To use the Windows utilities, you should install them first. But before that, make sure your computer meets 

the following minimum system requirements: 

 

 Operating systems: Windows 98/NT/2000/XP/Vista/Server 2000/2003 and XP/Vista/Server 

2000/2003 64-bit 

 Internet Explorer 5.0 or higher  

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

 128 MB of RAM 

 Hard disk drive with 40 MB of available space  

 SVGA video adapter and monitor  

 Mouse 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Linux/DOS based Recovery CD 

http://www.paragon-software.com/
http://kb.paragon-software.com/
http://kb.paragon-software.com/
mailto:sales@paragon-software.com
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To use the Paragon Linux/DOS Recovery CD on your computer (it doesn’t matter what operating system is 

installed), make sure that it meets the following minimum system requirements: 

 

 IBM AT compatible computer with i486 or higher CPU 

 256 MB of RAM  

 SVGA-compatible monitor 

 Mouse (recommended) 

 On-board BIOS supports booting from CD first 

 

There may be additional requirements if you want to use advanced features: 

 

 Network card is required to send partition/hard disk backups to a network computer or to retrieve 

previously made backups 

 Recordable CD/DVD drive is needed to burn data to compact disks 

 To save copy or backup of a hard disk or partition, removable USB disks can be used. The program 

supports USB Drives 1.0, 2.0.  

WinPE based Recovery CD 

To use the WinPE based Recovery CD on your computer, (it doesn’t matter what operating system is 

installed), make sure that it meets the following minimum system requirements: 

 

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

 At least 384 MB of RAM (512+ is recommended) 

 Hard disk drive with 40 MB of available space  

 SVGA video adapter and monitor 

  Mouse 

Installing the Program 

As we have already mentioned only Windows components of the product require installation. So to install 

Paragon Partition Manager 9.0 under Windows, please do the following: 

 

1. Run Setup Application 

From the folder, where the setup files are kept, run the SETUP.EXE file. This application will guide the user 

through the process of the program installation. The setup utility is compiled with the InstallShield SDK, 

hence it contains the standard user interface and set of installation steps. 

 

 

In case there is some previous version of the program installed on the computer, the program 

will offer the user to uninstall it first. 

 

2. Starting Setup 

The Welcome page informs that the application is being installed. Click the Next button to continue. 

 

3. Confirm License Agreement 

The License Agreement page displays the Paragon License Agreement. Read the agreement and then click 

the Yes button to accept. If the user does not agree with any conditions stated there, the installation process 

will be interrupted. 

 

4. Select an Installation Folder 

The Destination Location page allows the user to choose the folder where the program will be installed. By 

default, the installation folder will be created as: 
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C:\Program Files\Paragon Software\Paragon Partition Manager 9.0. To select another folder, click the 

Browse button. 

 

After you have selected the required folder, click the Next button to continue. 

 

 

Do not install the program on network drives. Do not use Terminal Server sessions to install 

and run the program. In both cases, the program functionality will be limited 

 

5. Select Components to Install 

 

The Select Components page enables the user to choose what components are to be installed. 

 

 
 

Besides Partition Manager 9.0 the user can also install a trial version of Drive Backup™ 8.51 as a bonus 

from Paragon Technology GmbH. So choose the required component(s) by marking a checkbox opposite its 

title. A brief description to the selected feature on the right will help make no mistake. 

 

Click the Next button to continue. 

 

 
Partition Manager 9.0 will be installed anyway as it is the main component. 

 

6. Select a Program Group 

The Program Folder page enables the user to select the application's program group for the Start Menu. By 

default, it will be the program group: 

 

Start > Programs > Paragon Partition Manager 9.0. 

 

Click the Next button to continue. 

 

7. Verify Setup Settings 

The Start Copying page allows the user to verify settings, which have already been made and correct them if 

necessary. Press the Back button to return to the previous page and modify the installation settings. Click the 

Next button to complete the installation process. 
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8. Copying Files 

The Setup Status page shows the overall progress of the installation. Click the Cancel button to abort the 

setup. 

 

9. Finishing the Installation 

The Final page reports the end of the setup process. 

 

 

To accomplish online backup/copy of locked partitions/hard disks the program uses a kernel 

mode hotcore driver, thus the system reboot is required to complete the installation 

procedure. 

Booting from the Linux/DOS Recovery CD 

The Linux/DOS Recovery CD can be used to boot your computer into PTS DOS or Linux to get access to 

the hard disk without use of the failed operating system. 

 

You also have an option to boot in the PTS DOS safe mode. The reboot of the computer from the Recovery 

CD in the safe mode may be of great use in a number of non-standard situations such as interfering hardware 

settings or serious problems on the hardware level. In this case, only basic files and drivers (such as hard 

disk drivers, a monitor driver, and a keyboard driver) will be loaded. 

Boot Menu 

After you have inserted the Recovery CD into CD/DVD drive and restarted the computer, the Boot menu 

appears. 

 

 
 

The Boot menu contains the following commands: 

 

 Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers 

(recommended). 

 Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux 

normal mode if it fails to work properly. 

 Low Graphics Safe mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of 

drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple 

graphics and a simple menu. No partitions mounted. 

 Floppy Disk. Reboot the computer from a system floppy disk. 

 Hard Disk 0. Boot from the primary hard disk. 

 Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any 

bootable operating system. 

 

To move within the menu, please use the arrow keys of the computer keyboard.  
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To automatically boot from the Recovery CD make sure the on-board BIOS is set up to boot 

from CD first. 

 

While working with the Recovery CD you might experience some inconvenience caused by 

possible video artifacts. It is just a result of changing video modes and in no way will affect 

the program functionality. If this is the case, please wait a bit and everything will be OK. 

Normal Mode 

When the Normal mode is selected, the Linux launch menu appears: 

 

 
 

 Paragon Partition Manager (enables to carry out partitioning operations of any complexity, copy 

and back up separate partitions or entire hard disks, defragment FAT and NTFS volumes, etc.); 

 Simple Restore Wizard (allows restoring hard disks and partitions); 

 File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording 

them to CD/DVD); 

 Boot Corrector (helps to correct the Windows System Registry without Windows being loaded); 

 Network Configurator (starts the Network Configuration Wizard); 

 

 

If you are going to use network resources, first launch the Network Configuration Wizard to 

establish a network connection. 

 

 Log Saver (helps to collect and send the necessary log files to the Technical Support) 

 View the mounted partitions (the list of all mounted partitions will be displayed); 

 

 

Linux/DOS Recovery CD assigns drive letters to partitions the way it is done in DOS, i.e. one 

after another, primary partitions at first. Thus mounted partitions may have different drive 

letters from Windows. 

 

 Command Line (allows experienced users to execute any operation); 

 Reboot the computer; 

 Power off the computer. 

 

To move within the menu, please use the arrow keys of the computer keyboard. 
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Safe Mode 

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as 

for the Normal mode except the Network Configurator and Log Saver commands. Besides due to certain 

limitations of the PTS DOS environment, there is no possibility to burn CD/DVD disks. 

Low Graphics Safe Mode 

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality 

and looks similar to the Safe mode but graphically simpler. 

 

 

Running Commands 

To launch the required command you should take the following steps: 

 

1. Insert Paragon Linux/DOS Recovery CD into your CD/DVD drive; 

2. Reboot the computer; 

3. Select one of the boot modes (Normal, Safe, Low Graphics) in the Boot menu; 

 

 
By default the Normal mode will be automatically initiated after a 10 second idle period. 

 

4. Choose a command by using the arrow keys of the computer keyboard to move within the menu; 

5. Launch the command by pressing the Enter button. 

6. After it has been launched consult the help system by pressing ALT+F1 to know more on the 

subject. 

 

 

To automatically boot from the Recovery CD make sure the on-board BIOS is set up to boot 

from CD first. 
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Basic Concepts  

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain 

a general notion of the operation performance and makes it easier for the user to operate the program. 

Drive Partitioning 

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it 

is carved up and space is set aside for the operating system. Until recently most PCs used to have just one 

partition, which filled the entire hard disk and contained the OS. The situation has changed however, thanks 

to new cost-effective high capacity hard drives, thus opening up numerous possibilities for PC users, such as 

editing video, archiving music, backing up CD images, etc. Huge increase in space is great, but it poses a 

number of problems, most important of which are effective data organization and speed. 

 

Large drives are always going to take longer to search than smaller volumes, and an operating system is 

going to have its work cut out both finding and organizing files. It is for this reason that many people decide 

to invest in multiple hard drives, but there is an easy solution – drive partitioning. Partitioning lets you 

divide a single physical drive into a number of logical drives, each of which servers as a container with its 

own drive letter and volume label, thus enabling the operating system to process data more efficiently. 

Besides partitioning makes it possible to organize data so that it is easy to find and manage. You can set 

aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing video and another 50 GB for 

your favorite music collections to provide transparent data storage. 

 

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-

fragmentation or consistency check will not be that annoying and time-consuming any more. 

 

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system 

malfunction, you can get the system back on track in minutes by recovering it from a backup image located 

on the other partition of the hard drive. 

 

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while 

browsing the Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a 

necessity. In order to run several OSs on a single hard drive you are to create a corresponding number of 

partitions to effectively delineate the boundaries of each OS. 

 

All of the above-mentioned partitioning applications are implemented in the program. And all the necessary 

actions are performed by using the system of convenient wizards. This means that the user simply has to 

follow easy step-by-step instructions to make the appropriate settings.  

Backup Operations  

Since the advent of the computer age the best way to protect valuable information was to store it in form of 

archives on external media. In case of hard disk malfunction, its contents could be restored from the archive. 

Then backup soon became a common term to mean making duplications of data for protection purposes. 

 

Nowadays backup has become an essential routine operation for any serious information work. A modern 

backup archive uses the so-called image, a snapshot of the whole disk system (or its separate partitions). It 

not only includes the contents of all user-made files, but additionally contains the exact structure of 

directories, information about file allocation, file attributes and other related data. A backup image can be 

copied or moved like any ordinary file. 
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The user can store backup images on external media (CD/DVDs). This guarantees a high level of data 

protection as long as the backup media is kept secure. It is possible to store backup images on a local 

network drive as well. Special server-side software enables to secure and store backup images for the entire 

network. For this purpose computers named backup servers are used. Such a backup server provides nearly 

the same level of protection as external media. 

 

However, should the user not have a local network and/or it is inconvenient to record data onto external 

media, then the backup images can be stored in a specially secured place on the hard disk. This place is 

referred to as the backup capsule, which has an independent system layout (e.g. a separate partition) that will 

stay operable should the active file system be damaged. To avoid an accidental removing or unauthorized 

access of the backup data, this partition is hidden and thus cannot be mounted in the operating system. A 

single hard disk may contain only one backup capsule. However, the user can attach another hard disk with 

an existing backup capsule to the computer and restore from that as well without any problems. 

 

It is only possible to browse the contents of the backup capsule by using special software. The system of 

wizards that is implemented into the program is designed to work with the backup capsule. Thus, by storing 

disk images in the backup capsule the user obtains a reliable level of data protection.  

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Paragon Hot Processing & Volume Shadow Copy Service 

Offline versus Online Backup 

In the course of time there have been developed various methods of backing up data. Despite different work 

concept, all of them can be divided into two principal groups: offline (cold) and online (hot) backup 

techniques. 

 

As the name infers, offline backup can only be accomplished when the data is in consistent state (the 

operating system and all the applications are completely shut down). Actually it is the most preferable way 

of image creation, since backup software obtains an exclusive right to process data that guaranties high level 

of operating efficiency. However an offline backup is absolutely out of question when dealing with 24/7 

production environments. 

 

In contrast, online backup enables to create a consistent snapshot even as the data is currently modified. 

Online backups are particularly useful for systems with high availability requirements, but they won’t be 

accomplished until all active transactions are complete. The point is to provide a coherent state of all open 

files and databases involved in a backup, taking into account that applications may still keep writing to 

disks. As a result an online backup cannot boast high operating speed. 

 

Our program supports both offline and online methods of image creation. As far as online backup is 

concerned it offers its own hot processing algorithm together with the possibility to use snapshot 

technologies provided by the Microsoft VSS framework. 

Paragon Hot Processing Technology 

Paragon Hot Processing is an online backup technology for Windows NT+ family operating systems. 

Developed back in 2001, nowadays it is integrated with all backup solutions offered by the company. 
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Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During 

an online backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk 

write activity of applications and the operating system. The hotcore driver as an integral part of the program 

is installed during the setup procedure (that’s why the system reboot is required to complete the setup 

procedure). For the most part the driver is in the idle mode until it is activated with the program. While in 

this mode it bypasses any calls having no effect on the overall system performance, but a few kilobytes of 

the system memory. 

 

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows 

NT+ family operating systems providing both high operating efficiency as well as low hardware 

requirements. 

 

 

It is not recommended to use Paragon Hot Processing with active SQL Server 2003, 

Exchange 2003 or Oracle databases since the backup image contents may be corrupted. 

Volume Shadow Copy Service 

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the backup infrastructure for the 

Microsoft Windows XP/Server 2003 operating systems. It offers a reliable mechanism to create consistent 

point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 

leading backup solution vendors on the market, it is based on a snapshot technology concept.  

 

Initiated by a VSS aware backup utility, VSS creates snapshots for the selected volumes and represents them 

as virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the backup 

utility starts processing the data while applications keep writing to original volumes. 

 

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous 

snapshot of multiple volumes. This very feature can be particularly beneficial when backing up active SQL 

Server 2003, Exchange 2003 or Oracle databases located on multiple volumes the way it is recommended by 

Microsoft to improve the level of database performance and reliability, thus providing 100-percent data 

consistency. 

 

 

To use VSS it is necessary to have a mounted 300 MB+ NTFS partition. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Dynamic Disks 

One of the key features of our program is the possibility to process dynamic disks. As you probably know, 

MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Server 2003/Vista support four primary partitions per 

physical hard disk, one of which can be extended. Certainly there is the possibility to create logical drives 

within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows 

2000, Windows Server 2003 and Windows Vista follow the same strategy: You can have a maximum of 

four primary partitions, one of which can be an extended partition with logical drives. However, these 

operating systems also introduce a new disk configuration type - dynamic disk - which must be understood 

to effectively configure and manage hard disks. 

 

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only 

dynamic volumes. Regardless of what format you use for the file system, only Win2K computers can access 

dynamic volumes directly. However, computers that aren't running Win2K can access the dynamic volumes 

remotely when connected to the shared folders over the network. 
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Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic 

and Dynamic disks on the same hard drive. 

 

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from 

free disk space that is linked together from multiple disks), striped (a volume the data of which is 

interleaved across two or more physical disks), mirrored (a fault-tolerant volume the data of which is 

duplicated on two physical disks, and RAID-5 volumes (a fault-tolerant volume the data of which is striped 

across an array of three or more disks). 

 

With dynamic storage, you can perform disk and volume management without the need to restart Windows. 

 

Limitations: 

 

 Dynamic disks are not supported on portable computers. 

 Dynamic disks are not supported on Windows XP Home Edition-based computers. 

 You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows 

XP Professional, or Windows XP 64-Bit Edition-based computers. 

 

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more 

management flexibility without the partition limitation of basic disks. Dynamic disks can contain an 

unlimited number of volumes, but they cannot contain partitions or logical drives. Dynamic storage can be 

particularly beneficial for large-scale businesses when dealing with many physical hard disks involving 

complex setup. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

64-bit Support 

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end 

user. However that is not the case when dealing with servers processing large amounts of data with complex 

calculations of very large numbers. That is where 64-bit architecture comes into play.  

 

It can boast improved scalability for business applications that enables to support more customer databases 

and more simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such 

as memory allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses 

than a 32-bit processor. With these resources, even a very large database can be cached in memory.  

 

Although many business applications run without problems on 32-bit systems, others have grown so 

complex that they use up the 4 GB memory limitation of a 32-bit address space. With this large amount of 

data, fewer memory resources are available to meet memory needs. On a 64-bit server, most queries are able 

to perform in the buffers available to the database. 

 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For 

instance, system-level utilities and programs that provide direct hardware access are likely to fail. Our 

program offers a full-fledged support of the 64-bit architecture providing fault-tolerant work for such system 

dependent modules as Hot Processing. 

Copy Operations 
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Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite 

advantages it can offer. First of all, many people clone hard disks just to back up data for security reasons. 

The present day copy utilities enable to successfully transfer all on-disk information including standard 

bootstrap code and other system service structures, thus maintaining the operating system’s working 

capability. In case of a system malfunction, the user can get the system back on track in minutes. No 

additional configuration is required, what is very convenient. 

 

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard 

drive doubles every two years, thus opening up new possibilities for software developers. As a result 

programs become more complicated and require considerable amount of free space. One day the user 

realizes that there is no more free space left on the hard disk and the only way out is to upgrade. Usually that 

means that besides purchasing a new hard disk, the user is to face a large re-installation procedure spanning 

several days of tedious work. But all of this can be avoided just by copying the contents of the old hard disk 

to a new one proportionally resizing the partitions. 

 

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when 

setting up similar computers. There is no need for a system administrator to install an operating system from 

scratch on every one of them. It is enough just to configure one and then clone it to the others. 

Scheduling  

The automation of the program’s operations is particularly effective when the user has to repeat a sequence 

of actions on a regular basis. For example, when a specific project is being developed on a computer on a 

day-to-day basis and a backup copy is made every evening so as not to lose the valuable data, it should be 

possible to simplify certain routine operations. Certain operations really need to be automated to facilitate 

the task of multiple executions and setting a precise time for its completion. 

 

Another aspect of any automation process is that it runs automatically without the user having to be present. 

The program is able to execute operations without the user being involved. In addition, it allows an 

optimization of your computer’s work-load. This is especially important when operations require a 

considerable amount of computer resources – processor time, memory and more. A number of operations, 

which can decrease the performance, can be run during the night or whenever the computer has the least 

work-load to perform. 

 

The program has a special tool for scheduling. The user can set out a timetable for various operations. For 

example, some operations may be performed daily, others - weekly and so on. The scheduled operation 

starts at a specified time without interrupting the user's current activity. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Interface Overview  

This chapter introduces the graphical interface of the program to the user. The design of the interface 

precludes any mistake being made on the part of the user. Most operations are performed through the system 

of wizards. Buttons and menus are accompanied by easy understandable icons. Nevertheless, any problems 

that might occur while managing the program can be tackled by reading this very chapter. 

General Layout  

When the user starts the program, the first component that is displayed is called the Launcher. It enables the 

user to run wizards and utilities, to specify program settings, to visualize the operating environment and the 

hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 

functionality: 

 

1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  
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6. List of Partitions 

7. Disk Map  

8. Legend Bar 

9. Status Bar  

 

Some of the panels have similar functionality with a synchronized layout. The program enables the user to 

conceal some of the panels to simplify the interface management. 

 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the 

screen layout. 

Main Menu  

The Main Menu provides access to the entire functionality of the program. The available functions are as 

listed below: 

MENU ITEM  FUNCTIONALITY  

Tools     

Generate Script… Generate a script for the task 

Save to Scheduler… Schedule pending operations 

Send Log Files Compress and send the log to the Paragon Support Team 

Boot Manager… Manage several operating systems on one computer 

Recovery Media Builder… 
Restore the system even when the current operating system cannot boot 

anymore 

Settings... Edit the general settings of the program  

Exit  Exit the program  

Changes  

Undo "the last virtual 

operation" 
Cancel the last virtual operation on the List of Pending Operations 

Redo "the last virtual 

operation" 
Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info  Refresh the current information about disks  

Wizards    

Create Partition… Create a partition of any file system 

Format Partition… Format a partition of any file system 

Delete Partition… Delete a partition of any file system 

Back Up Disk or 

Partition… 
Create a new backup archive  

Restore Disk or Partition…  Restore a disk from the backup image  

Copy Hard Disk…  Create a hard disk copy  

Copy Partition…  Create a partition copy 
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Merge Partitions… Merge adjacent partitions of NTFS, FAT or FAT32 file systems 

Redistribute Free Space… Redistribute available disk space of existed partitions 

Undelete Partitions… Recover any of accidentally deleted partition 

Install New OS… Make your system ready to install a new operating system 

Hard Disk  

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Change Primary Slots… Modify the primary partitions enumeration for the selected hard disk 

Convert to Basic… Convert a dynamic disk containing simple volume(s) into basic 

Change SID… Change SID (Security Identifier) value of any found Windows installation 

Edit/View Sectors… View/edit sectors of the selected hard disk 

Properties… Get in-depth information on the properties of selected hard disk 

Partition  

Create Partition… Create a partition of any file system with the Create Partition dialog 

Format Partition… Format a partition of any file system Format Partition dialog 

Delete Partition… Delete a partition of any file system Delete Partition dialog 

Move/Resize… Move/Resize the selected partition 

Convert File System… Convert file system of the selected partition 

Assign Drive Letter… Assign drive letter to the selected partition 

Remove Drive Letter… Remove drive letter for the selected partition 

Hide Partition… Make the selected partition unavailable for the operating system 

Unhide Partition… Make the selected partition available for the operating system 

Mark Partition as Active Make the selected partition bootable by default 

Mark Partition as Inactive Make the selected partition non-bootable by default 

Change Cluster Size… Change cluster size of the selected partition 

Change Boot Size… Change boot size of the selected partition 

Change Root Size… Change root size of the selected partition 

Change Volume Label… Change volume label of the selected partition 

Change Serial Number… Change serial number of the selected partition 

Change Partition ID… Change identifier of the selected partition 

Downgrade NTFS 

version… 
Decrease version of the selected NTFS partition 

Compact MFT… Shrink MFT of the selected NTFS partition 

Change SID… Change SID (Security Identifier) value of any found Windows installation 

Make Partition Primary… Make the selected partition Primary 

Make Partition Logical… Make the selected partition Logical 

Defragment Partition… Defragment data on the selected partition 

Defragment MFT… Defragment MFT (Master File Table) of the selected NTFS partition 

Test Surface… Test surface of the selected partition/block of free space 

Check File System Check the selected partition for possible file system errors 
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Integrity… 

Edit/View Sectors… View/edit sectors of the selected partition 

Properties… Get in-depth information on the properties of selected partition 

View     

Toolbar  
Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons.  

Status Bar  Display the Status bar  

Common Tasks Bar  Display the Common tasks bar  

Disk Map Legend Display the Disk map legend 

Properties and Commands Display the Explorer bar 

Disk Map Location  
Select whether the Disk map will be located on the top of the main window or 

at the bottom  

Choose Columns… Select properties to display on the List of partitions 

Help     

Help  Open the Help system  

About  Open the dialog with information about the program  

 

 

The Main Menu contents available at the moment may vary depending on the selected object. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Tool Bar  

The Toolbar provides fast access to the most frequently used operations: 

BUTTON  FUNCTIONALITY  

 
Create a partition 

 
Copy a partition 

 
Copy a hard disk 

 
Format a partition 

 
Delete a partition 

 
Open the Help system 

Virtual Operations Bar  
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The program supports previewing the resulting layout of hard disks before actually executing operations (so-

called virtual mode of execution). In fact, when the virtual mode is enabled, the program does not 

accomplish operations immediately, but places them on the List of Pending Operations for later 

accomplishment. 

 

The Virtual Operations Bar enables to manage pending operations. 

 

BUTTON  FUNCTIONALITY  

 
Cancel the last virtual operation on the List of Pending 

Operations 

 
Cancel the last undo virtual operation on the List of 

Pending Operations 

 Display the List of Pending Operations 

 Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending 

Operations 

 

 

Virtual mode is an effective way of protection from any troubles, since no operations will be 

executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds the 

user that there are unsaved changes by showing the following window: 

 

Common Tasks Bar  

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the 

program's wizards that provide all the functionality needed to manage copy operations. 

The bar contains several tabs named Basic Partitioning Tasks, Advanced Partitioning Tasks, Backup Tasks, 

Copy Tasks, Tools and News and Documentation. Each of these contains a separate button bar which can be 

folded by clicking it. 

Basic Partitioning 

Tasks  
   

 
Starting the Create Partition Wizard. The Create Partition Wizard assists the user 

to create partitions of any file system. 

 
Starting the Format Partition Wizard. The Format Partition Wizard allows 

formatting existing partitions to one of the file systems supported by the program. 

 
Starting the Delete Partition Wizard that enables to delete partitions of any file 

system. 
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Advanced Partitioning 

Tasks  
   

 

Starting the Merge Partitions Wizard. The Merge Partitions Wizard allows 

merging adjacent partitions of NTFS, FAT, FAT32 file systems. 

 
Starting the Redistribute Free Space Wizard that enables to redistribute available 

disk space of existed partitions. 

 
Starting the Undelete Partitions Wizard that helps to recover accidentally deleted 

partitions. 

 
Starting the Install New OS Wizard that assists the user to install a new operating 

system. 

Backup Tasks  

 

Starting the Backup Wizard. The Backup Wizard assists the user with the backup 

of the hard disk’s data. 

 

Starting the Restore Wizard. The Restore Wizard helps to restore data from a 

previously made backup image. 

Copy Tasks 
 

 

Starting the Copy Hard Disk Wizard that helps to make an exact copy of a hard 

disk. 

 
Starting the Copy Partition Wizard that helps to make an exact copy of a partition. 

Tools 
 

 

Starting the Boot Manager Setup Wizard that enables to easily manage several 

operating systems on one computer. 

 

Starting the File Transfer Wizard. The File Transfer Wizard allows copying of 

separate files/directories or burning of them to CD/DVD. Besides it provides 

access to Paragon backups as regular folders to browse through their contents or 

copy required files. 

News and 

Documentation  
   

 

Opening the page which contains information about the program. This page will 

be displayed in the Explorer bar. 

 
Launching the Help system. 

 
Opening a brief review on the Paragon Scripting Language. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Disk Map  
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The Disk Map is displayed in the Explorer bar when the Disk View tab is selected. It is located either at the 

top or at the bottom of the window, depending on the state of the Disk Map Location option (Main menu: 

View > Disk Map Location). The user can change the current location of the map with this option. 

 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are 

represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. 

Their color depends on the file system of the appropriate partition. 

 

 
 

Large-sized bars display the following information about physical disks: 

 Manufacturer, 

 Model. 

 

Small-sized bars display the following information about logical disks: 

 Serial number, 

 Drive letter, 

 Total size, 

 File system. 

 

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. 

 

Disk Map is synchronized with the Explorer bar. When the user selects a disk on the Disk Map the Explorer 

bar displays detailed information of the selected disk. 

 

 

The user can click a large-sized bar to display information about the appropriate physical 

disk in the Explorer bar. A click on a small-sized bar will lead to displaying information 

about the appropriate logical disk. 

Explorer Bar 

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar 

displays reference information including: 

 

 User Manual, 

 Information about the program consisting of the product's name, the version of the program and a list 

of helpful links, 

 Detailed information about disks selected on the Disk Map, 

 List of scheduled operations, 

 Volume Explorer utility, 

 Disk Editor utility. 

 

According to these categories the Explorer bar has several tabs: 

 

 Disk View, which offers the user the following options: 

- Disk Editor to view/edit sectors of the selected partition/hard disk; 

- Volume Explorer to browse and export contents of the selected partition/hard disk; 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical 

form. 

 Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations. 
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 Help System, which contains the User Manual and information about the program. 

 

The user is able to access the desired information by clicking on the appropriate tab. 

 

The Explorer Bar is a fully-functional embedded HTML browser, which enables the user to address, for 

example, our company's website to look through important technical notes or download the latest updates 

without having to close the program. The Help System of the program is HTML-oriented. The user can read 

the user manual and follow external links from to get additional information. 

 

 
 

To easily navigate through browsed pages, the program provides the following functionality: 

 

BUTTON  FUNCTIONALITY  

 
Return to the previously browsed page  

 
Open the next browsed page  

 
Stop loading the current page  

 
Refresh the contents of the current page  

List of Partitions 

The List of Partitions is another helpful tool that enables the user to get a clear-cut picture of the current 

state of the system hard disks/partitions. Partitions are sorted according to their starting position. For every 

item of the list there is the possibility to call the context-sensitive popup menu with available operations. 

Besides, the program provides detailed information on all hard disks/partitions found in the system including 

the following properties: 

 

   - Name, 

   - Volume label (if exists), 
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   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 

   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector 

   - Free size in sectors/bytes 

   - Active/Inactive attribute 

   - Hidden/Unhidden attribute 

 

The user may customize the outlook of the List of Partitions with the appropriate Main menu item: View > 

Choose Columns… 

 

 
 

By marking checkboxes the user can choose whether the required item will be displayed or not. 

 

Furthermore, the List of Partitions is synchronized with the Explorer bar and the Disk Map. 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. The user can hide (or 

show) the bar with the appropriate Main menu item: View > Disk Map Legend. When it is activated it can be 

found at the bottom of the Explorer bar.  

 

The program distinguishes between the following types of known file systems: 

 

   - FAT16/32,  

   - NTFS, 

   - Linux Ext2/3,  

   - Linux ReiserFS. 
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Status Bar  

This is the bottom part of the main window. The status bar displays menu hints, for each item the cursor 

points to. 

 

The user can hide (or show) the bar with the appropriate Main menu item: View > Status bar. 
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Settings Overview 

The Settings dialog is available from the Main menu: Tools > Settings. All the settings are grouped into 

several sections of which the functions are described in the following paragraphs. The list of sections is 

placed on the left side of the dialog. By selecting a section from the list, the user opens a set of options. 

General Options  

 
 

This section contains a set of general options that will be taken into account during all the operations carried 

out with the program. The user can switch between the following modes: 

 Verify data written. If this option is marked, every write-to-disk action is followed by the 

read-and-compare action. This feature may be helpful in case of running an unstable hard 

disk, however it will negatively affect the overall performance. 

 Enable data loss protection. Activate the option to force the program to work in the fail-safe 

mode (also referred to as data-loss protection mode), which ensures more safety for 

operations by maintaining the special journal of operations’ progress. In case of hardware 

malfunction, power outages or operating system failure, the modified partition may become 

corrupted and non-operable. However, the program will be able to complete the interrupted 

operation, thus "reviving" the partition. 

If the system has crashed during the operation in the fail-safe mode, insert the bootable 

Recovery CD and restart the computer. The program will automatically detect the journal of 

the interrupted operation and complete the operation. 
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It is strongly recommended to enable this option. 

 Try to access non-BIOS disk cylinders. The option works only under Windows 95, 98, ME. 

When activated, the program performs a special procedure to define the disk capacity and does 

not use the value that is returned by BIOS. 

 Enable Initial Backup reminders. If this option is marked, the program will automatically 

offer the user to make a backup before accomplishing any critical partitioning operation, thus 

minimizing the risk of data loss. 

General Copy and Backup Options  

 
 

This section contains a set of options that will be taken into account during copy and backup operations. The 

user can switch between the following modes: 

 

 HDD raw processing. Activate the option to copy a hard disk in the sector-by-sector mode to 

successfully process unknown file systems. However it is not recommended to enable this option 

when working with supported file systems as it takes more time to accomplish the operation. 

 Partition raw processing. Activate the option to copy a partition in the sector-by-sector mode to 

successfully process unknown file systems. However it is not recommended to enable this option 

when working with supported file systems as it takes more time to accomplish the operation. 

 Perform incremental copy. Once the complete copy of a hard disk is created, it can be used as a 

base for the incremental copy. Mark the option to make the program perform the exact bit-wise 

comparison of the previous data (saved in the parental copy) with the current data (that is actually the 

hard disk itself). After that only most recent information will be processed. It considerably decreases 

the amount of data written. 

 Skipping OS auxiliary files during backup operation. 
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Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Hot Processing Options  

 
 

This section contains a set of options that will be taken into account in case the Hot Processing mode 

is enabled. The Hot Processing mode is a part of the backup/copy operation that allows the program 

to process a disk without restarting the computer. The program forces the system to restart to obtain 

exclusive access to the processing data. The Hot Processing mode may be used to process locked 

partitions or any backup/copy operation. The user defines the method in this section. 

 

The user can also set a Temporary drive. This option defines a partition (by default – C:) for the Hot 

Processing temporary file. The temporary file will be deleted when the hot backup/copy is performed 

which may require a large amount of disk space. Should there not be enough space on drive C:, then 

another drive needs to be selected. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Partitioning Options 
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This section contains a set of options that will be taken into account during partitioning operations. The user 

can activate the following modes: 

 

 64 KB cluster size for FAT16 partitions. Only Windows NT 4.0/2000/XP/2003 support 64 KB 

clusters. 

 Request confirmation before partition deletion. 

 Request confirmation when converting FAT16 to FAT32 during such partitioning operations as 

copy disk/partition, restore disk/partition. 

 Surface test level. The option affects the following operations: format partition, copy partition, 

restore partition, retest the surface. While performing the surface test, the program detects corrupted 

sectors and marks them as unusable. 

E-Mail Options 
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This section contains a set of options that will be taken into account during the Send log files and Send e-

mail notification operations. The user can define: 

 

 Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to 

have access to a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing 

messages are first sent to the SMTP server, which in its turn delivers them to the required recipients. 

The address may be represented as a traditional Internet host name (e.g.: mail.com) or as an IP 

numeric address (e.g. xxx.xxx.xxx.xx). 

 User e-mail address. Specify an e-mail address that has been assigned by the Internet Service 

Provider or organization's e-mail administrator. 

 My outgoing server requires authentication. Activate the option to allow the program to make 

authentication on the server before sending messages. 

- User name. Enter the name that will be used to log in to the e-mail account. 

- Password. Enter the password that will be used to access the mail server. 

 

 Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out 

operations.  

- Send mail in HTML format. Activate the option to create messages in the HTML format instead 

of plain text. 

- Send complete report after applying operations. Activate the option to create an in-depth report 

on the carried out operations and send it after performing the last operation. 

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow 

the program to attach two pictures of the disk layout made before and after the operation is 

completed. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Virtual Mode Options 

 
 

 Allow virtual mode. In this section the user can choose whether to allow operations to carry out 

immediately or to place them on the List of Pending Operations for later execution. Just mark the 

option to enable virtual operations. 

 Close progress dialog automatically. Mark the option to automatically close the progress dialog 

when the required operation(s) is completed. 

File System Conversion Options  
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This section contains a set of options that will be taken into account while converting file systems. By 

default, the program takes locale (regional) settings from the system. However, the user can customize 

default locale settings such as: time zone and language of file names. 

 

These parameters affect the conversion of file systems "FATxx ->NTFS" and "NTFS -> FATxx". The 

problem lies in the use of different standards for file names and file time stamps (Created, Modified and Last 

access time) of NTFS and FATxx file systems. 

 

Initially, the program displays the default locale settings, which may be changed: 

 Time zone. Specify the time zone to use during a file system conversion. NTFS keeps file 

timestamps in GMT (Greenwich Mean Time) while FAT uses the unadjusted local date and 

time. The program takes proper account of the difference between internal formats of file 

timestamps and enables to use the time zone information to adjust the timestamp values.  

 
In some cases incorrect use of the time zone may lead to inability to run certain software. 

 Language for file names. Choose the correct code page value. NTFS stores file names in 

Unicode while FAT/FAT32 file systems use ANSI encoding for saving short filenames (also 

called DOS aliases). The code page information is required for correct conversion of non-

English filenames from Unicode to ANSI and vice versa.  

 
Incorrect settings will result in corruption of non-English filenames. 

 



Paragon Partition Manager™ 9.0 40 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

 Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the option to 

automatically display the dialog of the locale settings confirmation every time the Convert file system 

operation is performed. 

Operation Dependency Options 

 
 

This section contains a set of options that will be taken into account when the Send e-mail notification on 

apply function is enabled. By marking the appropriate operations the user can choose whether to receive an 

e-mail notification after the particular operation is completed or not. However, the user will not be notified 

by e-mail in case operations (if any) require the system reboot. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

CD/DVD Recording Options  
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This section contains a set of options that will be taken into account during the CD/DVD burning operation. 

The user can define: 

 

 Recording speed. The user may define how fast a CD/DVD will be recorded (minimum, normal and 

maximum). Besides there is an automatic mode when the program will set the most appropriate speed 

for every CD/DVD. 

 Folder where the ISO image is to be placed. When the user decides not to physically burn a 

CD/DVD, but create an ISO image file, this very folder will be used to contain these images. 

 Data buffer size. Allocating the RAM memory for buffering data will make the process of recording 

more reliable. 

 Verify media after burn. Mark this option to be sure the backup data has been recorded without any 

mistakes. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Backup Image Options  
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This section contains a set of options that will be taken into account during the creating backup images and 

restoring disks from them. The user can activate the following modes: 

 

 Controlling archive integrity, 

 

 

Checking archive integrity enables to guarantee that all backup images created with the 

program are 100 percent flawless. Nevertheless if you decided not to control the archive 

integrity, the backup operation would take about 3-5% less time. 

 

 Automatic setting file names in case of complex archives, 

 Splitting images to several files, 

 Compressing a backup image. The user can also define the compression level. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Password Protection Options 
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 Protect archive with password. In this section the user can choose whether to automatically 

password protect all backup images created with the program or not. Just mark the option to enable 

password protection and type in the required password in the opened field. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Getting Information about Disks and their Images  

The program provides some helpful tools to get information on the properties of disks and peculiarities of 

existing backup images. 

Viewing Disk Properties  

The user is able to view in-depth information on the properties of hard disks. The main tools to extract this 

information are the Disk Map and the List of Partitions. The two represent the actual state of the computer’s 

hard disks. 

 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized 

bars. The small-sized bars represent logical disks (partitions). When the user selects a large-sized bar, the 

Explorer bar displays information about the disk in a bright, graphical form.  

 

 
 

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in 

form of a circular graph, where the color of a sector corresponds to a file system of an appropriate partition. 

On the right the user may see a table, which contains the following information: 

 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

 

Below there is a list of wizards available for the user. If the user clicks a corresponding record the 

appropriate wizard will be started. All default values for the operation parameters will correspond to the 

disk’s settings. The list of wizards contains a detailed description of tasks that can be performed by the 

wizard. This nullifies the possibility of selecting the wrong wizard. 
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When the user selects a small-sized bar (i.e. corresponding to a logical disk), the Explorer bar will display 

information on it as well. The page title will contain a drive letter, which is assigned to the disk. The disk 

layout graph will be colored in accordance with the volume ratio of the used space to the free space (the 

light colored sector). The table on the right will contain the following information: 

 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

 

Below there is a list of wizards, which may be called for this disk. All default values of parameters will 

correspond to the disk settings.   

Viewing Image Properties  

Before restoring a disk from an image it is necessary to be sure that it is the image you need. To obtain 

general information about an image you can use the Restore wizard. It is very convenient to use because it 

provides the possibility to cancel the operation at any step. 

 

There are several ways to launch the Restore Wizard: 

 

 In the Main menu: select Wizards > Restore Disk or Partition… 

 In Common Tasks bar: click the Restore item of the Wizards menu 

 

At first, the wizard displays the Welcome page – simply click the Next button at the foot of the dialog 

window. 
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The next page refers to Browse for Archive. Here you can select an image on your disk in the browser-like 

window. The section below (i.e. Archive File Details) displays a short description of the selected image, 

including: 

 

 information on a type of the archive contents (whether it contains the entire disk or just a partition), 

 whether the archive is compressed or not, 

 whether the archive is password protected or not, 

 the date, when the archive was created. 

 

 
 

The next page (i.e. What to restore) displays detailed information about the contents of the archive. It 

includes a full description of properties about the archived disks or partitions. 

 

If you want to restore the contents of the image click the Next button. In order to cancel, click the Cancel 
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button.  

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Viewing Image Contents  

The user may browse contents of the archives with a special utility called Volume Explorer. To launch the 

Volume Explorer the user should click the Disk View tab in the Explorer Bar and then choose Volume 

Explorer. 

 

 
 

In order to view contents of an archive, open it by double click of the left mouse button. 

 

Volume Explorer also provides the possibility to extract separate files and folders from archives without 

restoring the whole archive. 

 

Volume Explorer can work with any kinds of archives created by the program. For example, it can browse 

the Backup Capsule which is hidden from any standard Windows program. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Partition Management 

In this chapter you will find all the information necessary to carry out partitioning operations supported by 

the program. 

Basic Partitioning Operations 

Here you can learn how to accomplish basic partitioning operations (create, format, delete) supported by the 

program. To meet the requirements of any user these operations can be accomplished either with the help of 

easy-to-use wizards or through the corresponding dialogs. 

Create Partition 

The program provides the ability to create new partitions by using the DOS partitioning scheme. 

Restrictions 

1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports 

only hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named 

Basic Disks). 

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be 

created: 

 Two Extended Partitions on one hard disk 

 Five or more Primary partitions on one hard disk 

 If there is an Extended Partition on the disk, only three Primary partitions are allowed 

 

4. The program allows creating new partitions only within blocks of unpartitioned space. It cannot convert a 

free space on an existing partition to a new partition. 

Starting Wizard 

There are several ways to start the Create Partition Wizard: 

 

 In the Main menu: select Wizards > Create Partition… 

 On the Common Tasks bar: click the Create Partition item of the Wizards menu. 

 In the Toolbar: click the Create Partition button. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 
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Starting Dialog 

In order to start the operation the user should take the following steps: 

 

1. Select a block of free space on the Disk Map. 

 

2. Call the Create Partition dialog to define appropriate settings: 

 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Create Partition. 

Settings 

Despite different work algorithms, both the Create Partition Wizard and the Create Partition dialog provide 

the same level of functionality, thus let us just take as an example the dialog version of the operation. 

 

Define the future partition parameters with the Create Partition dialog. Initially the program suggests some 

consistent values for all parameters. In most cases, the user can just press the Yes button to confirm the 

operation. 
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 Define whether the partition will be Primary, Extended or Logical. Select the desired type of the 

new partition from this pull-down list. As a matter of fact, the available alternatives fundamentally 

depend on the type of the selected block of free space - within the Logical free space, only Logical 

partitions can be created; Within the Primary free space, both Primary partitions or the Extended 

Partition can be created. 

 Partition Size. Define the size (in MB) of the new partition. 

 Free space before. Define the position (in MB) of the new partition relative to the beginning of the 

block of free space. 

 Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition. 

 

 

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

 

 File system for new partition. From the pull-down list select a file system the newly created 

partition will be formatted to, otherwise the partition will remain unformatted (so that it will not be 

ready to use). 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in 

most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 

dialog page. Depending on the file system, the following options become available: 

 

 
 

 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 
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 Whether the surface test will be performed. Mark the option to make the program perform the 

surface test on the formatted partition. In this case, the program will find bad and unstable sectors 

and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file 

systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner 

control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the 

maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this 

spinner control. 

Results  

After the operation is completed the user receives a fully functional partition. 

Format Partition  

Any partition should contain some file system to be used for keeping data. The process of installing a file 

system is commonly known as formatting. A huge variety of file systems have been developed these days. 

The program provides the ability to format existing or newly created partitions of the following file systems: 

 

   - FAT12 & FAT16 

   - FAT32 

   - NTFS 

   - Ext2 

   - Ext3 

   - Linux Swap v. 2 

   - HPFS 

Starting Wizard 

There are several ways to start the Format Partition Wizard: 

 

 In the Main menu: select Wizards > Format Partition… 

 On the Common Tasks bar: click the Format Partition item of the Wizards menu. 

 In the Toolbar: click the Format Partition button. 
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After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 

 

 

Starting Dialog 

In order to start the operation the user should take the following steps: 

 

1. Select a block of free space on the Disk Map. 

 

2. Call the Format Partition dialog to define appropriate settings: 

 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Format Partition. 

Settings 

Despite different work algorithms, both the Format Partition Wizard and the Format Partition dialog 

provide the same level of functionality, thus let us just take as an example the dialog version of the 

operation. 

 

Define parameters of the formatting operation with the Format Partition dialog. Initially the program 

suggests some consistent values for all parameters. In most cases, the user can just press the Format button 

to confirm the operation. 

 



Paragon Partition Manager™ 9.0 53 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

 
 

 File system. Select the desired file system type from this pull-down list. In fact, the program displays 

only file systems that can be correctly placed to the selected partition, taking the capacity of the 

selected partition into account. 

 Volume label. Enter a label for the selected partition in this textual field. The Volume label is an 

irrelevant parameter of a logical drive that can be used for drive identification. 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in 

most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 

dialog page. Depending on the file system, the following options become available: 

 

 
 

 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Mark the option to make the program perform the 

surface test on the formatted partition. In this case, the program will find bad and unstable sectors 

and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file 

systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner 

control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the 

maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this 

spinner control. 

Results  

After the operation is completed the user receives a fully functional partition formatted to the file system 

specified. 

Delete Partition 

The program allows the user to delete partitions on hard disks partitioned with the DOS partitioning scheme. 

The program removes references to the partition from the Partition Table, so that the information from the 

deleted partition becomes inaccessible. The resulted disk space can be used to create new partitions.  

 

Contents of the deleted partition do not disappear from the disk but merely are unavailable for the operating 

system. 
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Starting Wizard 

There are several ways to start the Delete Partition Wizard: 

 

 In the Main menu: select Wizards > Delete Partition… 

 On the Common Tasks bar: click the Delete Partition item of the Wizards menu. 

 In the Toolbar: click the Delete Partition button. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 

 

 

Starting Dialog 

In order to start the operation the user should take the following steps: 

 

1. Select a block of free space on the Disk Map. 

 

2. Call the Delete Partition dialog to define appropriate settings: 

 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Delete Partition. 

Settings  

Despite different work algorithms, both the Delete Partition Wizard and the Delete Partition dialog provide 

the same level of functionality, thus let us just take as an example the dialog version of the operation. 

 

Define parameters of the delete operation with the Delete Partition dialog. 
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 Enter the volume label to confirm deleting. To confirm the deletion of the selected partition, enter 

its Volume Label. The actual Volume Label value is displayed above. 

 Do not ask volume label next time. Mark the option to inhibit confirmation of the partition deletion. 

Results 

The deletion of a partition takes only a fraction of a second. However, the program waits until Windows 

completes the modification of the disk layout. 

Advanced Partitioning Operations 

Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, 

undelete, etc.) supported by the program. 

Merge Partitions 

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent 

partitions, into a single, larger partition. The order, in which two partitions have been chosen, is important 

since the contents of the second selected partition will be placed in the folder of the first selected partition. 

 

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions. 

Starting 

There are several ways to start the Merge Partitions Wizard: 

 

 In the Main menu: select Wizards > Merge Partitions… 

 On the Common Tasks bar: click the Merge Partitions item of the Wizards menu. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 
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Settings 

The Merge Partitions Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

 

 The partition to expand. Select a partition that will be expanded to take contents of an adjacent 

partition. 

 

 
 

 The partition to merge with. Choose the second partition for the merge operation, the contents of 

which will be placed in the folder of the first selected partition. By default the program automatically 

offers a folder name to store files of the second partition, which however can be customized by the 

user. 
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Be particularly careful when selecting system partitions to process, since the incorrect order, 

in which two partitions have been chosen, will result in inability to boot the operating system. 

Results 

After the operation is completed the disk space of the two adjacent partitions will be consolidated. 

Redistributing Unused Space between Partitions 

The Redistribute Free Space Wizard helps to increase free space on one partition at the expense of unused 

space on others. By default, the wizard adds to the target partition the 50% of unused space of other 

partitions, which have been selected to donate space. The user can manually control what part of unused 

space will be left on a partition. The wizard automatically recalculates the positions of the partitions and 

moves their contents to new locations. 

Starting 

There are several ways to start the Redistribute Free Space Wizard: 

 

 In the Main menu: select Wizards > Redistribute Free Space… 

 On the Common Tasks bar: click the Redistribute Free Space item of the Wizards menu. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 
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Settings 

The Redistribute Free Space Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

 

 Partition to enlarge. Select a partition, the size of which will be increased at the expense of other 

partitions. Blocks of free space, if any will be automatically added to the target partition. 

 

 
 

 Partition to donate. Choose any partition(s) (not only adjacent) to donate free space if available.  
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 Partition size. By default, the program leaves 50% of the unused space on a partition and removes 

another 50% to add it to the target partition. However, the size to take can be customized by moving 

the slider at the bottom of the page or manually entering the exact value. 

 

 

Results 

After the operation is completed free space of the specified partition will be increased by using unallocated 

space of the hard disk and/or at the expense of unused space of the other partitions. 

Undelete Partition 

When deleting a partition, disk management software only removes references to it in the Partition Table so 

that a previously deleted partition can still be recovered (in case of valid restoration of the record in the 

Partition Table). The program provides the ability to find and recover these partitions. This function 

minimizes the hazard of occasional partitions deletion and is usually known as undelete. 

 

A restored partition will be fully functional, as long as other partitions were not created, moved or exceeded 

the disk space occupied by the partition. That is why the program enables the Undelete Partition function 

only for blocks of free space. 

 

The operation can be accomplished with the Undelete Partition Wizard. 

Starting 

There are several ways to start the Undelete Partition Wizard: 

 

 In the Main menu: select Wizards > Undelete Partitions… 

 On the Common Tasks bar: click the Undelete Partition item of the Wizards menu. 

 Select a disk on the Disk map and click the Recover Lost Partitions item on the page that appears in 

the Explorer bar. 
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After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 

 

 

Settings 

The Undelete Partition Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

  

 Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available disks 

and their partitions. 

 

 
 

 Manual setting of search criteria. Activate the advance mode 

 to manually specify: 

- A particular file system to look for; 
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- Required search criteria. 

 

 
 

 
To use the advance mode, a good knowledge of hard disk structure is required. 

Results 

After the operation is completed the user receives a fully functional partition. 

Installing a New Operating System 

Getting your computer ready to install a new operating system, especially when it is going to be an 

additional OS in the system, is a rather complicated task that implies quite a number of operations, from 

allocating space to create a new partition (resize, redistribution of free space) to formatting of the newly 

created partition to a particular file system and checking its surface for bad sectors to avoid possible data 

loss. Operating systems today are being supplied with basic tools of partitioning that only provide the ability 

to create a partition (in case there is enough unallocated space on the disk) and then format it to the specified 

file system type. To tackle this issue our program offers a handy Install New OS Wizard with the help of 

which the user can easily carry out all the necessary operations to install a new operating system. 

Starting 

There are several ways to start the Install New OS Wizard: 

 

 In the Main menu: select Wizards > Install New OS… 

 On the Common Tasks bar: click the Install New OS item of the Wizards menu. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 
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Settings 

The Install New OS Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

  

 Partition to install a new operating system. The program offers two ways of installing a new OS, 

i.e. to create a new primary partition for it or use an existing one. 

 

 
 

 
Only primary partitions can be used to install an operating system. 

 

- In case the first option has been marked, the wizard enables to specify: 

A hard disk (if several) where a new partition will be created. Thanks to an advanced program 

engine it is possible to use unallocated space of the disk (if any) and unused space of existing 

partitions to create a new partition; 
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To avoid any possible problems, a new partition will in no way be created as the first 

partition of the disk which already contains at least one partition. 

 

And its size. If there are blocks of free space on the disk, the wizard merges them all and allocates the 

resulted space for a new partition in the first place. If not, it takes 50% of unused space of an 

adjacent partition. However, the size to take can be customized by moving the slider at the bottom of 

the page. 

 

 
 

- In case the second option has been marked, the wizard enables to choose an existing primary 

partition to install a new operating system.  

 

 
 

 
You computer may fail if any other OS has already been installed on the selected partition. 

 

 Partition properties. On the next page of the wizard the user can set a number of additional 

parameters: 
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- Partition type. From the pull-down list select the desired file system type. In fact, the program 

displays only file systems that can be correctly placed to the selected partition, taking its capacity 

into account. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with 

the newly formatted partition. 

- Surface test level. Define the level of the surface check to make the program find bad and unstable 

sectors and mark them unusable in the file system metadata. 

 OS Label. Enter a label for the selected partition in the textual field. It will later be used for drive 

identification. 

 

 

Results 

After the operation is completed the wizard offers to restart the computer and launch installation of a new 

operating system. 

 

 

In order to launch the installation process you need to insert a bootable distributive CD/DVD 

of the required operating system. 

Move & Resize Partition 

The Move & Resize Partition function allows the user to modify the size and position of partitions on the 

hard disk keeping all on-disk information intact. 

 

In order to move/resize a partition the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Move/Resize Partition dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Move/Resize Partition … 

 On the Explorer bar: click on the current total size value. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Move/Resize Partition… 

 

3. Define parameters of the operation with the Move/Resize Partition dialog. 
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 Partition preview. The disk map displays the resulting disk layout after the move/resize operation is 

completed. 

 Partition size. Define the size (in Mb) of the modified partition. 

 Free space before. Define the position (in Mb) of the partition relative to the beginning of the 

available range of disk space. 

 Free space after. Define the amount of trailing free space (in Mb) at the end of the available range 

of disk space. 

 

 

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in 

most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 

dialog page. The following options become available: 

 

 
 

 Verify write operation. Define whether the Writing Verification test will be accomplished during 

the operation or not. 

 Sector to sector move. Activate the sector-to-sector mode (allows to process any file system, even 

unknown one). 

 Surface test level. Select from the pull-down list the level of the surface test. 

 

 

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the 

partition will be automatically converted to FAT32. 

 

The program enables to enlarge NTFS partitions (system, locked) without rebooting 

Windows and interrupting its work providing 100 percent guarantee that your data is kept 

intact. 

 

4. The operation will be performed immediately after confirmation. 

Convert File System 
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The program provides the ability to change the file system type without destroying data. While performing 

the operation, the program first checks for consistency the current file system and then verifies whether the 

on-partition data meet the requirements of the desired file system or not. After having passed the testing, the 

program re-organizes the file system metadata and user files. 

 

The program enables to convert the following file system types: 

 

- FAT16 > NTFS, FAT32 

- FAT32 > NTFS, FAT16 

- NTFS > FAT16, FAT32 

- Ext2 > Ext3 

 

In order to convert file system of a partition the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Convert file system of partition dialog to define appropriate settings: 

 

 Select in the Main menu: Partition > Convert file system… 

 On the Explorer bar: click on the current file system type. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Convert File System… 

 

3. Define parameters of the operation with the Convert file system of partition dialog. Initially the program 

suggests some consistent values for all parameters. In most cases, the user may just press the Convert button 

to confirm the operation. 

 

 
 

 Current file system. The dialog allows the user to get information on the selected partition. 

 New file system. The pull-down list contains file systems to convert to. The program only displays 

available variants, taking into account current parameters of the selected partition and the file system 

limitations. 

 Convert options. 

- New cluster size.  Define the Cluster Size for the partition to convert. 

 

 

The option is only available for FAT16>NTFS and FAT32>NTFS conversion.  

 

The user can only decrease the current cluster size. 

 

- Surface test level. Select from the pull-down list the surface test level. 

 

4. The operation will be performed immediately after confirmation. 
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Change Cluster Size 

Cluster Size is one of the important parameters of any file system. The Cluster Size value affects implicitly 

the performance of the files input-output activity since it defines the size of the file system metadata. 

Besides, the so-called waste space factor also depends on the Cluster Size value. 

 

The program provides the ability to change the Cluster Size to any available value without destroying data.  

 

In order to change the cluster size of a partition the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Change Cluster Size dialog to define appropriate settings: 

 

 Select in the Main menu: Partition > Modify > Change Cluster Size… 

 On the Explorer bar: click on the current sectors per cluster value. 

 

3. Define a new value with the Change Cluster Size dialog. 

 

 
 

Sectors per cluster. Select a new cluster size value from the pull-down list. 

 

 

The Cluster Size value is expressed in Sectors Per Cluster. To get the Cluster Size in Kbytes, 

divide it into half. 

 

4. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Make Logical/Make Primary 

The program provides the ability to include a Primary Partition in the Extended Partition, or exclude a 

Logical Partition from the Extended Partition, without partition duplication. 

 

In order to change a partition type the user should take the following steps: 

 

1. Select a primary or logical partition on the Disk Map. 

 

2. There are several ways to Make Partition Logical/Primary: 

 

 Select in the Main menu: Partition > Modify > Make Partition Logical/Primary. 

 On the Explorer bar: click on the current partition type. 
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The Make Primary > Logical option is only available when the selected partition is adjacent to 

the Extended partition and vice versa. 

 

The Make Primary > Logical option of the system partition will result in inability to boot the 

operating system. 

 

3. The operation will be performed immediately after confirmation. 

Changing Partition Attributes 

This chapter explains how the user can change partition attributes (Active flag, Hidden flag, Partition ID, 

Volume Label, etc.). 

Mark Partition Active/Inactive 

The program enables to set Active/Inactive flag for primary partitions of the hard disk. By default the 

operating system will boot from the active (bootable) partition at startup. 

 

In order to mark partition Active/Inactive the user should take the following steps: 

 

1. Select a primary partition on the Disk Map. 

 

2. There are several ways to Mark Partition Active/Inactive: 

 

 Select in the Main menu: Partition > Mark Partition Active/Inactive. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Mark Partition Active/Inactive. 

 

 
 

 

There can only be one active partition on a hard disk, otherwise the operating system will fail 

to boot. 

 

3. The operation will be performed immediately after confirmation. 

Hide/Unhide Partition 

The program allows the user to Hide/Unhide primary and logical partitions. The operating system does not 

mount hidden partitions, thus preventing access to their contents. 
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In order to Hide/Unhide a partition the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

2. There are several ways to Hide/Unhide partitions: 

 

 Select in the Main menu: Partition > Hide/Unhide Partition. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Hide/Unhide Partition. 

 

 

It is strongly recommended not to hide the system partition, otherwise the operating system 

will fail to boot. 

 

3. The operation will be performed immediately after confirmation. 

Set Label of a Partition 

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. 

This value is detectable by any partitioning tool; it is used for notification purposes only. 

 

In order to change a partition label the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Change Volume Label dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Change Volume Label. 

 On the Explorer bar: click on the current volume label. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Change Volume Label. 

 

3. Define the label of the partition with the Change Volume Label dialog: 

 

 
 

New volume label. Enter the new value of the Partition Label. The length of the Label is limited to 11 

characters. 

 

The dialog also displays the current partition label.  

 

4. The operation will be performed immediately after confirmation. 

Change Partition ID 
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Partition ID is an identifier of a file system that is placed in the partition. Partition ID is saved in the 

Partition Table; it is used to quickly detect partitions of supported types. By manually changing the Partition 

ID value, it is possible to manipulate the accessibility of partitions. 

 

In order to change a Partition ID the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Change Partition ID dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Change Partition ID… 

 On the Explorer bar: click on the current partition ID. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Change Partition ID… 

 

3. Define the ID of the partition with the Change Partition ID dialog: 

 

 
 

 Predefined ID. Select from the pull-down list ID values for various file systems. 

 Enter ID manually. The textual field contains a hexadecimal presentation of the Partition ID. 

Generally, the Partition ID should be presented as 1-2 digits hexadecimal number; only hexadecimal 

digits {0..9, A..F} are allowed to be used. 

 

4. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Change Serial Number of a Partition 

FAT16, FAT32, HPFS and NTFS file systems include the Serial Number parameter. The partition's Serial 

Number is saved in the boot sector; its value is generated while formatting a partition. 

 

The program enables to modify the partition's Serial Number on formatted FAT16, FAT32, HPFS and NTFS 

partitions without re-formatting. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a partition on the Disk Map.  
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2. Call the Change Partition Serial Number dialog to define appropriate settings. There are several ways to 

do it: 

 

 Select in the Main menu: Partition > Modify > Change Serial Number. 

 On the Explorer bar: click on the current serial number. 

 

3. Define the parameter value with the Change Partition Serial Number dialog. 

 

 
 

New serial number. The user can enter the new Serial Number value in this textual field. The Serial 

Number should contain 8 hexadecimal figures (0..9 or A..F). The operation cannot be accomplished until the 

user enters all 8 symbols. 

 

4. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Change Boot Size 

Major file systems use initial sectors of a partition to store the bootable code of an operating system. This 

area of a partition is generally known as the Bootable Area, or the Boot Sector (actually it takes up several 

sectors). 

 

The program provides the ability to modify the Bootable Area size of the FAT formatted partitions without 

destroying data. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a FAT partition on the Disk Map.  

 

2. Call the Change Boot Size dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Change Boot Size… 

 On the Explorer bar: click on the current sectors per boot value. 

 

3. Define parameters of the operation with the Change Boot Size dialog. 
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Sectors per boot. Specify a new Boot Size value. 

 

4. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Change Root Size 

The maximum capacity of the Root Directory is an essential parameter of old FAT12 and FAT16 file 

systems. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a FAT partition on the Disk Map.  

 

2. Call the Change Root Size dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Change Root Size… 

 On the Explorer bar: click on the current root entries value. 

 

3. Define parameters of the operation with the Change Root Size dialog. 

 

 
 

Root entries. Specify a new Root Directory Size value. 

 

4. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Hard Disk Management 

This chapter lists various scenarios of hard disk operations which may be accomplished by the program. 

Update MBR 

The program allows the user to overwrite the current bootable code in the MBR (Master Boot Record) by 

the standard bootstrap code.  

 

This feature can repair corrupted bootable code on a hard disk as a result of boot virus attacks or 

malfunction in the boot managing software. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a hard disk on the Disk Map.  

 

2. There are several ways to run the operation: 

 

 Select in the Main menu: Hard Disk > Update MBR. 

 Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 

then select the menu item: Update MBR. 

 

 
 

3. The operation will be performed immediately after confirmation. 

Convert to Basic 

The program provides a unique possibility to convert a dynamic disk containing simple volume(s) into basic 

keeping its contents intact. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a dynamic disk containing simple volume(s) on the Disk Map or on the List of Partitions.  

 

2. Call the Convert to Basic dialog selecting in the Main menu: Hard Disk > Convert to Basic… 

 

3. Define parameters of the operation with the Convert to Basic dialog. 

 



Paragon Partition Manager™ 9.0 74 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

 
 

Number of primary partitions. According to the DOS partitioning scheme a hard disk can only have no 

more than four Primary partitions. If there is an Extended partition on the disk, only three primary partitions 

are allowed. That is why if a dynamic disk contains several simple volumes the program allows the user to 

choose the number of primary partitions. The rest of them if any will automatically be converted to logical 

disks within the Extended partition.  

 

 

The program can only process dynamic disks containing solid simple volumes (without 

extension). 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Change Primary Slot 

Operating systems use the following partitions enumeration: 

 

In Linux: 

In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a 

partition itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are 

automatically generated by Linux in accordance with the order of hard disks in BIOS and the order of 

partition records in the Partition Table. The modification of primary partitions enumeration can lead to the 

changing of paths to some important resources. 

 

In DOS: 

The last versions of MS-DOS use a rather sophisticated algorithm for drive letters assignment. A drive letter, 

which is assigned to a partition, depends on the order of records in the Partition Table. The modification of 

primary partitions enumeration affects the drive letters assignment. In early versions of  

MS-DOS, it can even lead to the unavailability of a partition. In any case, the user may want to change the 

enumeration of primary partitions.  

 

The program provides the ability to change the enumeration of primary partitions. This feature allows the 

user to fix problems concerning the inappropriate order of partitions. 

 

In order to modify the enumeration of partitions the user should take the following steps: 

 

1. Select a hard disk on the Disk Map.  
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2. Call the Change Primary Slot dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Hard Disk > Change Primary Slot. 

 Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 

then select the menu item: Change Primary Slot. 

 

 
 

3. The dialog displays the actual enumeration of Primary Partitions in the Partition Table (it exhibits the 

order of appropriate records, which refer to primary partitions in the primary part of the Partition Table 

referencing records. The top part of the dialog displays the enumeration order of partitions with the 

parameters that can help to distinguish partitions: 

   - Slot 

   - Volume 

   - Partition type 

   - File system 

   - Partition size  

   - Volume label 

 

There are two buttons on the right of the list of primary partitions, which allow the user to move the selected 

partition up and down within the primary part of the Partition Table. 

 

4. The operation will be performed immediately after confirmation.  

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Data Backup and Rescue 

In this chapter you will find all the information necessary to establish a reliable data protection system. 

Creating Backup Images 

We have already mentioned that the most prevalent way to protect valuable data is to create backup copies 

(backup images in terms of the program) of it. This operation can be accomplished with a handy wizard 

(Backup Wizard for the Enterprise Server edition and Simple Backup Wizard for the other editions). The two 

wizards have much in common, except the following features: 

 

 Only the Backup Wizard provides the possibility to store backup images on: 

- Local unmounted (without drive letter assigned) partitions; 

- External media (CD/DVD) to guarantee a high level of data protection as long as the backup media 

is kept secure; 

- A special secured place on the hard disk called the Backup Capsule; 

 Only the Backup Wizard enables to set a number of additional parameters (compression level, image 

splitting, password protection, recording speed, OS auxiliary files skipping etc.)  

Starting  

There are several ways to start the Backup Wizard/Simple Backup Wizard: 

 

 In the Main menu: select Wizards > Back Up Disk or Partition…/Simple Backup 

 On the Common Tasks bar: click the Back up hard disks or selected partitions/Simple Backup 

item of the Wizards menu. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed. 

 

 



Paragon Partition Manager™ 9.0 77 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

 

In Paragon Drive Backup the company offers a number of more sophisticated solutions of 

data and system backup. To know more on the subject, please follow the link on the first page 

of the wizard. 

Settings  

Since the work algorithm of both wizards is the same, but the Backup Wizard is richer in the provided 

functionality, let us just take it as an example. The Backup Wizard allows the user to configure the settings 

and then start the operation in accordance with the entered parameters. Here the user sets the parameters of 

the backup operation defining: 

 The object to back up. The user can backup either an entire disk or separate partitions of the 

disk (primary, extended or logical). In case of backing up an entire disk, the user has the 

possibility to include into the image such disk elements as the Master Boot Record (MBR) 

and the first track of the hard disk. This can be very helpful for serious disk recovery 

procedures. 

 

 Backup destination. The Backup Wizard allows saving backup archives to local or network 

drives, to physical partitions (without drive letters assigned), the Backup Capsule or burning 

them to CD/DVDs. The user needs to select a destination, taking the estimated archive size 

and available space on the backup destination into account. 

 

 Name and location of the resulted image. Provide a file name for the new image and its 

exact location. The program automatically offers an easy to understand name containing the 

date and the time of the archive creation, which can anyway be modified. 
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The program automatically calculates size of the future archive and informs the user about 

space available on the selected destination.  

 Archive Comment. The user can add some additional description to the archive that will 

later help to distinguish it from the others. 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in 

most cases). To activate the advance mode, the user needs to mark the appropriate option on the second page 

of the wizard (i.e. the What to back up page). The checkbox is to be found at the foot of the page 

. When it is marked, the next page allows the user to define: 

 

 Whether the archive integrity will be controlled. 

 

 

Checking archive integrity enables to guarantee that all backup images created with the 

program are 100 percent flawless. Nevertheless if you decided not to control the archive 

integrity, the backup operation would take about 3-5% less time. 

 

 Whether image file names will be set automatically in complex archives. 

 Compression level for the backup image (including the No compression variant). 

 Whether the archive will be split (if this is the case the user can set the maximum size for the archive 

files). 

 

 
Splitting images enables to tackle issues caused by a file size limitation of some file systems. 

 

 Whether the archive will be protected by password. 

 Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode 

(including unused sectors as well). 

 Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image. 

 Recording speed when the user wants to burn the backup image onto CD/DVDs. 

 ISO image folder where the archive that is to be recorded on a disc, is placed. 
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 Whether the operation will be performed without rebooting the system. The program needs to 

reboot the system in order to have exclusive access to processing data. In a Windows environment 

this is difficult to achieve because even when all the other applications are closed, the system service 

programs are still running. However, there is a way to avoid rebooting. The mode of processing the 

backup operation without rebooting is named Hot Processing. The user is also able to define specific 

parameters for the Hot Processing mode. 

Results  

After the backup operation is completed the user receives an image of the selected disk (or the selected 

partition). This image is placed into the specified destination (a local (mounted/unmounted) or network disk, 

the Backup Capsule or a CD/DVD disc), its features defined by the wizard. 

 

 

The program allows the user to back up all five types of dynamic volumes (simple, spanned, 

striped, mirrored, RAID-5). 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Backup to a Local Partition 

Backup Wizard 

To save a backup archive on a local mounted/unmounted (without drive letter assigned) drive with the 

Backup Wizard, please do the following: 

1. Click the Backup hard disk or selected partitions item of the Wizards menu (any of the 

ways described earlier can also be used here to call the Backup Wizard). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 

partition’s name depending on the chosen task. Click the Next button. 

4. On the Backup Destination page, select the Save data to local/network drives or Save data 

to physical partitions option. Click the Next button. 

5. Depending on the choice, select a local mounted/unmounted disk as a backup destination. 

 

Please take into account values of the parameters Estimated archive size and Space available 

on backup destination - if the archive size exceeds the available space, another drive needs to 

be selected. 

6. Edit the archive name if necessary and click the Next button. 

7. Add comments to your backup describing its contents. Click the Next button. 

8. On the Backup Summary page review all parameters of the operation and modify them if 

necessary. Click the Next button to accomplish the operation. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Simple Backup Wizard 

To save a backup archive on a local mounted drive with the Simple Backup Wizard, please do the following: 

1. Click the Simple Backup item of the Wizards menu (any of the ways described earlier can 

also be used here to call the Simple Backup Wizard). 

2. On the Wizard's Welcome page, click the Next button. 
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3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 

partition’s name depending on the chosen task. Click the Next button. 

4. On the Backup Destination page, select a local disk. Click the Next button. 

 

Please take into account values of the parameters Estimated archive size and Space available 

on backup destination - if the archive size exceeds the available space, another drive needs to 

be selected. 

5. Edit the archive name if necessary and click the Next button. 

6. On the Backup Summary page review all parameters of the operation and modify them if 

necessary. Click the Next button to start the backup process. 

Backup to a Network Drive 

Backup Wizard 

To save a backup archive on a network drive with the Backup Wizard, please do the following: 

1. Click the Backup hard disk or selected partitions item of the Wizards menu (any of the 

ways described earlier can also be used here to call the Backup Wizard). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 

partition’s name depending on the chosen task. Click the Next button. 

4. On the Backup Destination page, select the Save data to local/network drives option. Click 

the Next button. 

5. Select a network disk (it must be mounted and be available in the system by a drive letter). 

 

Please take into account values of the parameters Estimated archive size and Space available 

on backup destination - if the archive size exceeds the available space, another network drive 

needs to be selected. 

6. Edit the archive name if necessary and click the Next button. 

7. Add comments to your backup describing its contents. Click the Next button. 

8. On the Backup Summary page review all parameters of the operation and modify them if 

necessary. Click the Next button to start the backup process. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Simple Backup Wizard 

To save a backup archive on a network drive with the Simple Backup Wizard, please do the following: 

1. Click the Simple Backup item of the Wizards menu (any of the ways described earlier 

can also be used here to call the Simple Backup Wizard). 

2. On the Backup Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name 

or a partition’s name depending on the chosen task. Click the Next button. 

4. On the Backup Destination page, select a network disk (it must be mounted and be 

available in the system by a drive letter).  

 

Please take into account values of the parameters Estimated archive size and Space available 

on backup destination - if the archive size exceeds the available space, another network drive 

needs to be selected. 
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5. Edit the archive name if necessary and click the Next button to accomplish the 

operation. 

6. On the Backup Summary page review all parameters of the operation and modify them 

if necessary. Click the Next button to start the backup process. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Backup to External Media (CD/DVD) 

To store backup images on CD/DVD with the Backup Wizard, please do the following: 

1. Click the Backup hard disk or selected partitions item of the Wizards menu (any of the 

ways described earlier can also be used here to call the Backup Wizard). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 

partition’s name depending on the chosen task. Click the Next button. 

4. On the Backup Destination page, select the Burn the data to CD or DVD option. Click the 

Next button. 

5. Select a recordable device on the list and edit the archive name, if necessary. Click the Next 

button. 

6. Add comments to the backup describing its contents. Click the Next button. 

7. On the Backup Summary page review all parameters of the operation and modify them if 

necessary. Click the Next button to start the backup process. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Backup to the Backup Capsule 

To place backup images into the backup capsule with the Backup Wizard, please do the following: 

 

1. Click the Backup hard disk or selected partitions item of the Wizards menu (any of the ways 

described earlier can also be used here to call the Backup Wizard). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 

partition’s name depending on the chosen task. Click the Next button. 

4. On the Backup Destination page, select the Save data to the Backup Capsule option. Click the Next 

button. 

 

 

Please take into account values of the parameters Estimated archive size and Space available 

on backup destination. 

5. Edit the archive name if necessary and click the Next button. 

6. Add comments to your backup describing its contents. Click the Next button. 

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. 

Click the Next button to start the backup process. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Restoring System and Data  

The program includes a convenient and reliable restore wizard. It provides easy to understand instructions 

which allow the user to configure and perform all the necessary settings. 

 

 
All contents on the disk selected for restoring purposes will be deleted during the operation. 

Starting  

There are several ways to start the Restore Wizard: 

 

 In the Main menu: select Wizards > Restore Disk or Partition… 

 On the Common Tasks bar: click the Restore item of the Wizards menu. 

 

After any of the mentioned actions the Welcome page of the wizard will be displayed. 

 

 

Settings  

The Restore Wizard allows the user to configure the settings and start the operation in accordance with the 

entered parameters. In our case we set the following parameters of the restore operation: 

 

 A backup image to be restored. The Browse for archive page enables to browse disks for an 

appropriate backup image.  

 

The user can find the required image in the browser-like window. The section below (i.e. Archive 

File Details) displays a short description of the selected image. 
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Moreover, on this page the user has the possibility to create new folders or delete existing 

files/folders by clicking the appropriate buttons. 

 

 An item of the selected archive to be restored. The program allows the user to restore not only an 

entire archive, but also separate items of the archive. It is very convenient in case of restoring 

separate partitions from the entire disk archive. 

 

 
 

 A place to restore the archive to. Selecting the destination, please note - all contents on the disk 

selected for restoring purposes will be deleted during the operation. 

 

 
 

To help the user get a clear-cut picture of the operation outcome, the program allows inspecting the 

resulted disk layout. 
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Restoring Partition:  

 Size of the restored volume and free space before and after it on the disk. 

 

 
 

 Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be 

associated with the restored partition. 

 

 

Restoring Hard Disk: 

 Copy data and resize partitions proportionally. If this option is activated, the program 

proportionally changes the size of partitions keeping their relative order intact. The option can be 

useful when restoring to a larger hard disk. 

 Perform surface test. Define whether the surface test will be accomplished during the operation or 

not. 

 

 

Results  

The wizard will restore a disk (or partition) that has been archived, and make it available to use in the 

operating system.  

 

The user has the ability to restore original dynamic volumes as dynamic volumes of any type, 

providing the targeted dynamic disk is of the appropriate size. Moreover the program 

enables to restore dynamic volumes as basic partitions and vice versa. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Restoring from the Backup Capsule 
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OS is still bootable 

To restore a hard disk/partition from the backup image contained in the Backup Capsule with the Restore 

Wizard, please do the following: 

 

1. Click the Restore disk or partition item of the Wizards menu (any of the ways described earlier can 

also be used here to call the Restore Wizard). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, select the required archive in the browser-like window. The 

Archive File Details section displays a short description of the selected image. Click the Next button. 

4. The What to Restore page displays detailed information about the contents of the archive. It 

includes a full description of properties about the archived disks or partitions. In case you have a 

complex archive, select the required item to restore. 

5. On the Where to Restore page select a place you would like to restore the archive to. 

6. On the Restore Results page review all parameters of the operation and modify them if necessary. 

Click the Next button to start the restore process. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Restoring from External Media (CD/DVD) 

OS is still bootable 

To restore a hard disk/partition from the backup image located on CD/DVD with the Restore Wizard, please 

do the following: 

 

1. Insert a CD/DVD disk containing the previously prepared backup image into a CD/DVD drive. 

 

 
In case the backup image is stored on several CD/DVD disks, please insert the first one. 

 

2. Click the Restore disk or partition item of the Wizards menu (any of the ways described earlier can 

also be used here to call the Restore Wizard). 

3. On the Restore Wizard's Welcome page, click the Next button. 

4. On the Browse for Archive page, select the required archive in the browser-like window. The 

Archive File Details section displays a short description of the selected image. Click the Next button. 

5. The What to Restore page displays detailed information about the contents of the archive. It 

includes a full description of properties about the archived disks or partitions. In case you have a 

complex archive, select the required item to restore. 

6. On the Where to Restore page select a place you would like to restore the archive to. 

7. On the Restore Results page review all parameters of the operation and modify them if necessary. 

Click the Next button to start the restore process. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

 

OS is not bootable due to some failure 

 

To restore a hard disk/partition from the backup image located on CD/DVD when the current OS is down, 

please do the following: 
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1. Insert a CD/DVD disk containing the previously prepared backup image into a CD/DVD drive (the 

BIOS must be enabled to boot the system from the CD/DVD device). 

 

 

This scenario implies that you have got a bootable archive on your CD/DVD. 

 

In case the backup image is stored on several CD/DVD disks, please insert the first one. 

 

2. Restart the computer. 

3. The Simple Restore Wizard™ will be started automatically. Click the Next button on the Welcome 

page. 

4. On the What to Restore page, either type the full path to the backup image of the disk, which 

you are going to restore, or click the standard browse button [...] to find it. Click the Next button. 

5. On the Image Properties page, make sure that you select the correct image viewing the provided 

information about the archive. When the archive has been chosen, click the Next button. 

6. On the disk layout map, select a disk, to be restored. Click the Next button. 

7. Set the size of the partition. The user can compress or expand it at the expense of available unused 

space. Click the Next button. 

8. Click the Finish button to initiate the restoring process. 

9. After completing the operation reboot the computer. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Restoring from a Network Drive 

To restore a hard disk/partition from the backup image located on a network drive, please do the following: 

WinPE Recovery CD 

1. Insert Paragon WinPE Recovery CD (the BIOS must be enabled to boot the system from the 

CD/DVD device). 

2. Restart the computer. 

3. Launch the Restore Wizard by clicking the Backup and Rescue button of the Express Launcher 

and then selecting the Restore/Simple Restore item. 

4. On the Restore Wizard's Welcome page, click the Next button. 

5. On the Browse for Archive page, select the required archive in the browser-like window. The 

Archive File Details section displays a short description of the selected image. Click the Next button. 

6. The What to Restore page displays detailed information about the contents of the archive. It 

includes a full description of properties about the archived disks or partitions. In case you have a 

complex archive, select the required item to restore. 

7. On the Where to Restore page select a place you would like to restore the archive to. 

8. On the Restore Results page review all parameters of the operation and modify them if necessary. 

Click the Next button to start the restore process. 

9. After completing the operation reboot the computer. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Linux/DOS Recovery CD 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 

CD/DVD device). 

2. Restart the computer. 
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3. Set up a network connection by selecting the Network Configurator item of the main menu. 

4. Launch the Simple Restore Wizard. Click the Next button on the Welcome page. 

5. On the What to Restore page, either type the full path to the backup image of the disk, which 

you are going to restore, or click the standard browse button [...] to find it. Click the Next button. 

6. On the Image Properties page, make sure that you select the correct image viewing the provided 

information about the archive. When the archive has been chosen, click the Next button. 

7. On the disk layout map, select a disk, to be restored. Click the Next button. 

8. Set the size of the partition. The user can compress or expand it at the expense of available unused 

space. Click the Next button. 

9. Click the Finish button to initiate the restoring process. 

10. After completing the operation reboot the computer. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Copying of data from the corrupted system disk to another hard disk 

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails 

to boot, simply do the following: 

 

1. Connect the second hard disk to the computer. 

2. Insert Paragon WinPE or Linux/DOS Recovery CD (the BIOS must be enabled to boot the 

system from the CD/DVD device). 

3. Restart the computer. 

4. Launch the File Transfer Wizard. Click the Next button to continue. 

 

 

You can start up the File Transfer Wizard in the WinPE version of the program just the way 

it is done in Windows. However when dealing with the Linux/DOS Recovery CD, you can do 

it from the main menu. 

 

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the 

page. 

6. Choose files you want to copy and place them to Clipboard by pressing the left arrow-button. 

7. Choose the way the data will be stored. Select the Save data to local drives or physical 

partitions item. Click the Next button to continue. 

8. On the Select Destination Path page, select a hard disk to copy the data to by pressing the Browse 

button. Click the Next button to accomplish the operation. 

9. After the operation is completed, exit the wizard by pressing the appropriate button. 

10. Eject the CD. 

11. Turn off the computer. 

Burning of data from the corrupted system disk to CD/DVD 

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, 

simply do the following: 

 

1. Insert Paragon WinPE or Linux/DOS Recovery CD (the BIOS must be enabled to boot the 

system from the CD/DVD device). 

2. Restart the computer. 

3. Launch the File Transfer Wizard. Click the Next button to continue. 
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You can start up the File Transfer Wizard in the WinPE version of the program just the way 

it is done in Windows. However when dealing with the Linux/DOS Recovery CD, you can do 

it from the main menu. 

 

4. Select a disk where the files you need are stored from the pull-down list in the right pane of the 

page. 

5. Choose files you want to copy and place them to Clipboard by pressing the left arrow-button. 

6. Estimate the resulted data size by pressing the Calc button. Click the Next button to continue. 

7. Choose the way the data will be stored. Select the Burn data to CD/DVD item. Click the Next 

button to continue. 

8. On the Choose a recorder page, select a recorder from the list and then set a volume label by typing 

it in the appropriate field. Click the Next button to continue. 

 

 
The program enables to burn data either to a CD/DVD or an ISO image. 

 

9. Insert a blank CD/DVD. In case the inserted disc is not empty, the program suggests the user 

erasing its contents. Click the Next button to accomplish the operation. 

10. After the operation is completed, exit the wizard by pressing the appropriate button. 

11. Eject the CD. 

12. Turn off the computer. 

Copying of data from a backup to the corrupted system partition 

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can 

recopy these files to make the system be operable again: 

 

1. Insert Paragon WinPE or Linux/DOS Recovery CD (the BIOS must be enabled to boot the 

system from the CD/DVD device). 

2. Restart the computer. 

3. Launch the File Transfer Wizard. Click the Next button to continue. 

 

 

You can start up the File Transfer Wizard in the WinPE version of the program just the way 

it is done in Windows. However when dealing with the Linux/DOS Recovery CD, you can do 

it from the main menu. 

 

4. Select a disk where the system backup is stored from the pull-down list in the right pane of the 

page. 

5. Open the required backup, choose files you want to copy and place them to Clipboard by pressing 

the left arrow-button. 

6. Choose the way the data will be stored. Select the Save data to local drives or physical 

partitions item. Click the Next button to continue. 

7. On the Select Destination Path page, select the required system disk to copy the data to by pressing 

the Browse button. Click the Next button to accomplish the operation. 

8. After the operation is completed, exit the wizard by pressing the appropriate button. 

9. Eject the CD. 

10. Turn off the computer. 

Restoring Separate Files and Folders from a Backup 

To restore separate files and folders from a backup image with the Volume Explorer, simply do the 

following: 
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1. Click the Disk View tab and then choose Volume Explorer; 

 

 
 

2. Browse for the required archive and then open it by double click of the left mouse button. 

 

 
 

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the 

Export item. 

 

 
 

4. Select a place on the disk where the file/folder will be extracted to. 
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5. Click the OK button to accomplish the operation. 

Build Recovery Media  

The program provides the possibility to prepare a set of recovery tools on external media (CD, DVD or 

floppy disks). The tool set can be of assistance in case of operating system corruption, which means that the 

user is able to boot the computer even when the operating system is not able to do so. Creation of such 

recovery tools is performed with the Recovery Media Wizard.  

Starting  

To start the Recovery Media Wizard the user needs to select the Recovery Media Builder item of the Wizards 

menu on the Common Tasks bar. Then the Welcome page of the wizard is displayed. 

 

 

Settings  

The Recovery Media Wizard allows the user to configure the settings and start the operation in accordance 

with the entered parameters. In our case we set the parameters of the future recovery tool by defining: 
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 Type of the recovery media the user is creating. The recovery tools can be placed either on a 

CD/DVD disc or on a floppy disk. 

 

 
 

 Contents of the recovery set. The recovery tools can include the standard Recovery Media image 

(included in the installation package) or software defined by the user. In the last case the user can 

record a prepared image by setting the path to the image file on the disk. 

 

 
 

 A recording device. The appropriate external media (CD/DVD or a floppy disk) needs to be inserted 

into the selected device. 

 CD/DVD writing parameters (in case the user selects this kind of media). Writing parameters 

include writing speed (maximum or minimum) and the ability of ejecting the recorded disc after 

completing the operation. 

 

 
 

The program supports CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW and also DVD-R, DVD+R 

double layer discs. If the inserted disc is not empty, the Wizard suggests the user erasing its contents. When 

the user confirms the operation, the program deletes the re-writable disc's contents and begins the recording 

process.  

Results  

The Recovery Media Wizard starts the operation after completing the settings mentioned above. As a result, 

the user receives recovery media, which can be used in most emergencies. 

 

When purchasing the program online, Recovery Media is available as ISO-image files. The Recovery Media 

Builder can then write these files onto physical CD/DVDs.  
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Copy Tasks  

This chapter lists various scenarios of copy operations which may be accomplished by the program. 

Copy Hard Disk 

The program provides the ability to clone hard disks of any file system. During the hard disk copying 

process, the program moves controlling records of used partitioning scheme, the bootstrap code and on-disk 

partitions. This operation cannot be substituted by simply copying all on-disk partitions.  

 

The operation can be accomplished with the Copy Hard Disk Wizard. The wizard is so well designed that 

the user simply needs to follow its easy instructions to make an exact copy of the disk.  

Starting  

There are several ways to start the Copy Hard Disk Wizard: 

 

 In the Main menu: select Wizards > Copy Hard Disk… 

 On the Common Tasks bar: click the Copy Hard Disk item of the Wizards menu. 

 In the Toolbar: click the Copy Hard Disk button. 

 Select a disk on the Disk map and click the Copy Hard Disk item on the page that appears in the 

Explorer bar. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed.  

 

 

Settings 
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The Copy Hard Disk Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

 The hard disk to copy. Select a hard disk you want to copy. 

 

 The target hard disk. Select a hard disk (if several) where all data of the source disk will be 

copied to. 

 

 Copy parameters. The Copy Hard Disk Wizard allows the user to specify the following 

options: 

 

 

Copy options 
- HDD raw copy to copy a hard disk in the sector-by-sector mode to successfully process unknown 

file systems. 

- Partition raw copy to copy a partition in the sector-by-sector mode to successfully process 

unknown file systems. 

- Perform incremental copy to make the program perform the exact bit-wise comparison of the 

previous data (saved in the parental copy) with the current data (that is actually the hard disk itself). 

After that only most recent information will be processed. It considerably decreases the amount of 

data written. 
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Resize options 
- Remove free blocks between partitions. If this option is activated, the program does not keep blocks 

of free space between partitions on the targeted hard disk. 

- Copy data and resize partitions proportionally. If this option is activated, the program 

proportionally changes the size of partitions keeping their relative order intact. The option can be 

useful when upgrading the hard disk to a larger one. 

 

Verification options 
This section allows the user to define whether the Surface and/or the Writing verification tests will be 

accomplished during the operation. 

Results 

After the operation is completed the user receives a fully functional duplicate of the existing hard disk. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Copy Partition 

The copying of partitions can be used either for cloning sample partitions or for making backup copies of 

working partitions.  

 

The user can duplicate partitions to protect oneself from downtime in case of a system malfunction. The 

partition can be copied back to the original place within a few minutes or can be used simply for copying 

separate files.  

 

The program duplicates all usable partition data including files, the exact structure of directories and file 

system metadata: location of files, security information, access quotas and so on. The program allows to 

copy partitions only to blocks of free space. 

Starting  

There are several ways to start the Copy Partition Wizard: 

 

 In the Main menu: select Wizards > Copy Partition… 

 On the Common Tasks bar: click the Copy Partition item of the Wizards menu. 

 In the Toolbar: click the Copy Partition button. 

 Select a disk on the Disk map and click the Copy Partition item on the page that appears in the 

Explorer bar. 
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After following one of the above mentioned actions, the Welcome page of the wizard is displayed.  

 

 

Settings  

The Copy Partition Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user sets the parameters of the operation defining: 

 

 The partition to copy. Select a partition you want to copy. 

 

 
 

 Destination disk. Select a hard disk with enough unallocated space to perform the operation. 
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The program enables to copy a partition to a block of free space, which is smaller than the 

partition itself, taking into account only actual amount of data. 

 

 Copy parameters. The Copy Partition Wizard allows the user to specify the following options: 

 

 
 

- Partition size. Define the size (in Mb) of the copied partition.  

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of 

the available range of disk space.  

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range 

of disk space. 

 

 

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. 

Results 

After the operation is completed the user receives a fully functional duplicate of the existing partition. 
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Boot Management 

Our program enables to easily manage several operating systems on one computer with the help of the Boot 

Manager Setup Wizard. Among the key features of the wizard the following should be mentioned: 

 

 Up to 16 operating systems on one PC; 

 Secure adding/removing of the Boot Manager startup record to/from the MBR; 

 Auto Boot option to automatically start up the previously chosen OS after a certain time period; 

 Hiding of any primary partition except selected at the moment. 

 

The wizard is so well designed that the user simply needs to follow its easy instructions to properly 

configure the startup process. 

Starting  

There are several ways to start the Boot Manager Setup Wizard: 

 

 In the Main menu: select Tools > Boot Manager… 

 On the Common Tasks bar: click the Boot Manager Wizard item of the Wizards menu. 

 

After following one of the above mentioned actions, the Welcome page of the wizard is displayed.  

 

 

Settings  

The Boot Manager Setup Wizard allows the user to configure the settings and then start the operation in 

accordance with the entered parameters. Here the user should set the following parameters: 
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 Hiding other primary partitions. By marking this option the program will automatically 

assign the hidden flag to all primary partitions of the hard disk(s) except the one selected to 

boot. This will help to avoid any problems when dealing with different operating systems or 

different versions of one and the same OS, as they will be unaware of each other. 

 

 Boot menu options. In this section the user can switch between the following modes: 

- Normal mode. Choose this mode to display the boot menu every time the computer starts up 

and define a timeout on the expiry of which the program will automatically select the 

previously chosen item of the menu. 

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this 

mode the user should define a hot key used to enable the Boot Manager and a time period in seconds 

the startup message will be displayed. 

 

 Deactivating/Configuring the Boot Manager. These two options will only be available once the 

wizard has been completed and launched again. Select the Deactivate option to remove the Boot 

Manager from the MBR (Master Boot Record) or Configure to modify the previously set parameters 

of the startup process. 

 

 

Results  

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to 

get control of the booting process and to be able to display the boot menu. 

 

The operation will be performed immediately after confirmation. No virtual mode is 

available. 

Creating Dual Boot Systems  

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In 

this connection we decided to consider two the most frequently used situations a rank and file user may face, 

i.e. Windows Vista + Windows XP and Windows XP + Windows Vista. Please note that for reasons of 
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better security and system independence these operating systems will be installed on different partitions. 

That is why we need to hide the first system partition before installation of the second OS. 

Windows Vista + Windows XP 

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except 

one thing – your favorite applications simply reject to work correctly on it. Software updates are expected to 

release in the near future, but you cannot wait any more. Thus the best way out is to leave Windows Vista 

intact and install the time-proved Windows XP. 

 

Most likely you have only one hard disk with only one partition (the only partition is always system). To 

install the second operating system you need to repartition your drive first, as it requires a separate primary 

partition. If this case, the following scenario is just what you need: 

 

 

This scenario implies that operating systems will be installed on different partitions to 

provide better security and system independence. 

 

1. In the main window of Partition Manager select your hard disk on the Disk Map to make a block 

of free space on it; 

 

 
 

2. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do 

that, please call the context menu for the selected partition (right click of the mouse button) and 

launch the Move/Resize dialog; 
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3. In the opened dialog shift the edge of the partition to the left by the drag-and-drop technique. 

While doing this, free space from the partition will be released (displayed in aqua-green). You can 

also do it manually by entering the exact size of free space. Click the Yes button to continue; 

 

 
 

 

The Move/Resize dialog offers a number of additional parameters that can also be of help. 

However here we pay attention on the most relevant to fulfill our task. 

 

4. Now the user has a block of free space sufficient in size to hold a new partition; 

 

 
 

5. Create a new partition to install Windows XP. To do that, please call the context menu for a 

newly created block of free space (right click of the mouse button) and launch the Create Partition 

dialog; 
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6. Define parameters of the future partition. By all means it has to be primary and since we are 

going to install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes 

button to continue; 

 

 
 

 

The Create Partition dialog offers a number of additional parameters that can also be of 

help. However here we pay attention on the most relevant to fulfill our task. 

 

7. As a result of the operation we have got a newly created FAT32 partition just enough in size to 

comfortably work with Windows XP; 

 

 
 

8. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP 

installation, as it is the best way to provide system independence. To do that, please call the context 

menu for it (right click of the mouse button) and launch the Hide Partition dialog. Click the Yes 

button to continue; 
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Hiding of the system partition will make OS non-bootable, what is quite normal. 

 

 
 

9. Apply all introduced changes. By default, Partition Manager works in the virtual mode of 

execution, so you have to confirm all operations to let the program accomplish them. To do that, just 

click the Apply button on the Virtual Operations Bar; 

 

 
 

 

To perform the pending operations the program will need to restart the system into a special mode of 

execution. 

 

 

After all the operations are completed you will not be able to restart the system, what is quite 

normal. Nevertheless if you do try it, the following error will occur: 

 
 

All the mentioned above operations can be accomplished with the help of the Linux/DOS 

Recovery CD. 

 

10. Install Windows XP on the newly created partition. We won’t go into details as for its 

installation, as you can find all the necessary information in documentation that comes with the 

product. However to avoid any problems, we consider it necessary to draw your attention on the 

following issues: 

- You need a bootable distributive CD of Windows XP to install it; 

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot 

from CD first or press F12 during startup to select a bootable device; 

- Do not forget to select the newly created partition as destination. 
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Installation of Windows XP will make Windows Vista non-bootable. 

 

11. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you 

need to install Partition Manager 9.0 once again, but this time in Windows XP to activate Boot 

Manager. 

 

 

To avoid double installation of the program, you can use WinPE Recovery CD to activate 

Boot Manager. 

 

12. To launch the Boot Manager Setup wizard, please click the Boot Manager Wizard item of the 

Wizards menu; 

 

 
 

13. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other 

primary partitions except the one selected to boot and it is by all means should be activated to make 

Windows Vista and Windows XP unaware of each other. The rest of the parameters offered by 

default will do in our case, so just complete the wizard and it will automatically find the two 

operating systems and update the MBR. 
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14. Now restart the computer to make sure you have got a dual boot system. 

Windows XP + Windows Vista  

If you’ve got Windows XP and are willing to try the latest Windows Vista but not sure your favorite 

applications will flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and 

install Windows Vista for studying purposes. 

 

As this very situation is very close to the previous one, please use the Windows Vista + Windows XP 

scenario but taking into consideration a number of peculiarities: 

 

1. Besides hiding of the system partition before installation of the second OS you need to make it 

inactive as well. To do that, please call the context menu for it (right click of the mouse button) and 

launch the corresponding dialog. Click the Yes button to continue; 

 

 

Reviving the System Partition 

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached 

the point when all changes are applied and everything is ready to install the second OS, simply do the 

following to make your system bootable once again: 

 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 

CD/DVD device). 

2. Restart the computer. 

3. Select the Partition Manager 9.0 item of the main menu. 
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4. In the main window of Partition Manager select your non-bootable Windows partition on the 

Disk Map; 

 

 
 

5. Unhide the partition by calling the context menu for it (right click of the mouse button) and then 

selecting Unhide; 

 

 
 



Paragon Partition Manager™ 9.0 106 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

6. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as 

well by calling the context menu for it (right click of the mouse button) and then selecting Set 

Active; 

 

 
 

7. You will be notified after the operations are completed. 

 

 
 

8. Restart the computer. 

 

As a result your Windows becomes bootable once again. 
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Scheduling Operations 

The program allows the user to automate the backup/copy operations. The utility for this purpose is referred 

to as the embedded Scheduler, which is used to specify the time for the execution of the backup/copy 

operation. There are two categories for time settings (these correspond to appropriate items in the Schedule 

type menu): 

 Initiating the backup/copy operation by an event: 

- One time only (i.e. the Once item) 

- When system starts (i.e. the At System Startup item) 

- When the user logs on (i.e. the At Logon item). 

 Initiating the backup/copy operation periodically (i.e. Daily, Weekly, Monthly). 

The user just needs to select one of the variants. Depending on the choice, the scheduler will display a form 

that enables to set the schedule. 

 

 
 

 

To run the task in the log-off mode, please specify administering login info by following the 

appropriate link in the left lower corner of the page. 

 

The Shutdown System on Complete option enables to automatically switch off the computer on 

the successful accomplishment of the operation. 

 

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab 

in the Explorer bar: 
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On every task the user can get in-depth information, including: 

 

 The task name 

 The full path to the generated script of the task 

 Scheduled time of launch 

 Statistics on the last launch 

 Scheduled time of the next launch 

 Used account information 

 Comments to the task 

 

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by 

clicking on the required property. 

 

 

This feature can be particularly beneficial when the Scheduled Tasks list contains too many 

items. 

 

It is also possible to enable/disable, rename, delete, refresh or modify additional properties of the selected 

task. 

 

To modify additional properties of the selected task with the Task Editor, the user should select the 

Properties item of the context menu, which can be called by a right-click on the appropriate task. 

 

 
 

The dialog window has two tabs - General and Schedule. The General tab contains: 

 

 The full path to the program-interpreter of the macro-commands which describes the scheduled task 
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 The line of parameters for starting the interpreter (i.e. the task described in macro-language) 

 Comments referring to the task 

 The option of enabling/disabling the task. 

 

The Schedule tab contains the timetable of the task, which the user can modify. In order to apply the 

changes, the user needs to click the Apply button at the foot of the dialog. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Save to Scheduler 

Besides automating backup/copy operations, the program provides the ability to schedule any virtual 

operation placed on the List of Pending Operations. The automation of the program’s operations is 

particularly effective when the user has to repeat a sequence of actions on a regular basis. For instance, you 

are to restore the system every evening so as to get it back on track again. That is where this feature can help 

you out. It enables to execute certain routine operations without the user being involved. Moreover it allows 

an optimization of your computer’s work-load. 

 

In order to start the operation the user should take the following steps:  

 

1. Call the Save to Scheduler dialog in the Main menu: Tools > Save to Scheduler… 

 

2. Specify the time for the execution of operations on the List of Pending Operations.  

 

 

This command is unavailable if there are no operations on the List of Pending Operations. 

 

To learn more about how to set a timetable for execution please consult the Scheduling 

Operations chapter. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Scripting 

The program actions can also be represented in form of a script. The script describes the appropriate 

operation with macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included 

in the program installation package. This utility works in the unattended mode, which allows the user to 

automate operations. 

Starting 

The user may not write a script since the program has a convenient interface for such a task. In order to 

generate a script on the base of the entered parameters of the required operation, the user should take the 

following steps: 

 

 Select in the Main menu: Tools > Generate Script…  

 

 
This command is unavailable if there are no operations on the List of Pending Operations. 

Settings 

Define script generation options with the Generate script dialog. 

 

 
 

 Script file destination. The program allows saving script files to local drives. Press the Browse 

button to define destination and a filename for a new script file. The default file extension that is 

reserved for scripting files is .psl. However, a script can be saved under any filename. 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in 

most cases). To activate the advance mode, the user needs to click the More options button at the foot of the 

dialog page. The following options become available: 
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 Interaction with the user. Mark the option to pause the script interpreter during the execution to 

prompt the user’s confirmation or other input. Otherwise the program will not stop using default 

values for parameters if needed. 

 Commit after each operation. Mark the option to commit changes after each operation. 

 Check for errors after each operation. Mark the option to insert a special code in script, which 

checks the status of the last executed operation and stops the script processing if there are errors of 

any kind. 

 Discard all operations on close. Mark the option to empty the List of Pending Operations after 

generating the script. 

Results  

After the operation is completed the user receives a new script file. It is placed into the specified destination, 

its features defined in the dialog. 

 

 

To learn more about scripts please consult the Paragon Scripting Language manual. 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 
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Extra Functionality 

This chapter describes the supplementary functionality available in the program. 

View Partition/Hard Disk Properties 

The program enables to obtain in-depth information on the properties of hard disks/partitions. Besides the 

general information, such as capacity, used space or file system type it provides the possibility to get info on 

a hard disk geometry, cluster size, exact partition location, etc. 

 

In order to view properties of a partition/hard disk the user should take the following steps: 

 

1. Select a partition/hard disk on the Disk Map. 

 

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map 

or on the List of Partitions, then select the menu item: Properties… 

 

 
 

3. The provided information is grouped according to its properties, thus select the required tab and get the 

information you need. 

Volume Explorer 

Volume Explorer is a special tool providing the ability to browse and export contents of the local 

mounted/unmounted volumes formatted to FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. 

Besides it allows the user to access Paragon backups as regular folders to explorer their contents or to 

retrieve certain files. 

 

To launch the Volume Explorer the user should click Disk View tab in the Explorer Bar and then choose 

Volume Explorer: 
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Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other 

location (local or network drive, etc.). 

 

 

File Transfer Wizard 

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning 

of them to CD/DVD as easy and convenient as possible. It may be of particular use in case of a system 

malfunction, caused either by a virus attack or files corruption, in order to get the system back on track 

again. Besides it provides access to Paragon backups as regular folders to browse through their contents or 

copy required files. 

Starting 

To start the File Transfer Wizard the user needs to select the File Transfer Wizard item of the Wizards menu 

on the Common Tasks bar. Then the Welcome page of the wizard is displayed.  
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Settings 

The File Transfer Wizard allows the user to configure the settings and then start the operation in accordance 

with the entered parameters. Here the user sets the parameters of the operation defining:  

 

 Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the 

page. The program enables to process both mounted and unmounted (without drive letter assigned) 

partitions. Besides it is possible to map a network drive. 

 

 
 

 Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by 

pressing the Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane 

and press the Remove button. You can also create a new folder, rename or irreversibly delete existing 

files/directories of the left pane by pressing the appropriate buttons. 
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Files/directories deleted from the Clipboard remain intact on source disks. 

 

 Destination to store the object(s). The File Transfer Wizard allows copying data to local or network 

drives, to physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose 

the way the data will be stored. 

 

 
 

 Revision of changes. The Operation Summary page provides structurally divided information on all 

the actions made in the wizard. Check the changes and come back to any of the steps of the wizard to 

correct them (if necessary) by following the required hyperlink. 

 

 
 

Results  

The File Transfer Wizard starts the operation after completing the settings mentioned above. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Mount Partition 

The program allows the user to assign or remove drive letters of existing formatted partitions. 

Assign Drive Letter 
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In order to mount a partition the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Add Drive Letter dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Assign Drive Letter… 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Assign Drive Letter… 

 

3. Define a drive letter for the selected partition with the Add Drive Letter dialog. Initially the program 

suggests some consistent value for this parameter. So the user may just press the Yes button to confirm the 

operation. 

 

 
 

Assign the following drive letter. The pull-down list contains vacant drive letters that can be associated 

with the selected partition. Assign a drive letter to a non-mounted partition, or change the existed drive letter 

for already mounted partition. 

 

4. The operation will be performed immediately after confirmation. 

Remove Drive Letter 

In order to unmount a partition the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Remove Drive Letter. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Remove Drive Letter. 

 

 
 

 

Modifying drive letter of the system partition will result in inability to boot the operating 

system. 

 

After having processed partitions with installed software, some programs may not run 



Paragon Partition Manager™ 9.0 117 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

properly. 

 

3. The operation will be performed immediately after confirmation. 

Partition Defragmentation 

Defragmentation is the process of rewriting parts of a file to contiguous sectors on a hard disk to increase the 

speed of access and retrieval. When files are updated, the computer tends to save these updates on the largest 

continuous space on the hard disk, which is often on a different sector than the other parts of the file. When 

files are thus fragmented, the computer must search the hard disk each time the file is opened to find all of 

the file's parts, which slows down response time. 

 

The program provides the necessary tool for the defragmentation of NTFS and FAT partitions. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a partition on the Disk Map.  

 

2. Call the Defragment Partition dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Defragment Partition… 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Defragment Partition… 

 

3. Define parameters of the operation with the Defragment Partition dialog. Initially the program suggests 

some consistent values for all parameters. In most cases, the user may just press the OK button to confirm 

the operation. 

 

 
 

 Directories Placement. From the pull-down list select the way how to sort directories. 

 Sort by size. Sort files according to their size. 

 Sort by time. Sort files according to the last time of update. 

 Skip auxiliary files. Mark the option to ignore contents of the PAGEFILE.SYS and HIBERFIL.SYS 

system files. These files are used temporarily in the operating system. 

 

4. The operation will be performed immediately after confirmation. 
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MFT Defragmentation 

The MFT (Master File Table) is an NTFS system file that contains in-depth information on files, including 

size, time and date stamps, permissions, and data contents. In the course of time the MFT file can also be 

fragmented, thus slowing down the speed at which data is accessed. 

 

The program offers its users a special tool to defragment the MFT file. 

 

In order to start the operation the user should take the following steps: 

 

1. Select an NTFS partition on the Disk Map.  

 

2. Call the Defragment MFT dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Defragment MFT… 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Defragment MFT… 

 

 
 

3. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Compact MFT 

The program enables to re-write MFT (Master File Table) in a more compact way that will also increase 

access speed to files on NTFS partitions.  

 

In order to start the operation the user should take the following steps: 

 

1. Select an NTFS partition on the Disk Map.  

 

2. Call the Compact MFT dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Compact MFT… 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Compact MFT… 

 

3. Define parameters of the operation with the Compact MFT dialog. Initially the program suggests some 

consistent values for all parameters. 
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 Compact records. Mark the option to re-write MFT records and shift them to the head of the table.  

 Truncate MFT after compacting. Mark the option to remove table rows emptied during the 

operation. 

 

4. The operation will be performed immediately after confirmation. 

 

 

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Downgrade NTFS Version 

The program provides the ability to decrease version of existed NTFS partitions. This feature can be 

particularly useful when, for instance, dealing with different versions of the Windows NT family operating 

systems. 

 

In order to start the operation the user should take the following steps: 

 

1. Select a partition on the Disk Map or on the List of Partitions. 

 

2. Call the Downgrade NTFS Version dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Modify > Downgrade NTFS Version… 

 On the Explorer bar: click on the current NTFS version. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Downgrade NTFS Version… 

 

3. Define parameters of the operation with the Downgrade NTFS Version dialog. 

 

 
 

Select new NTFS version. The program enables to select the required NTFS version from the pull-down list 

of available versions. 

 

4. The operation will be performed immediately after confirmation. 
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Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Change SID 

SID - Security IDentifier, the binary structure that is associated with some object in the system, is used to 

distinguish between user access privileges in workgroup local networks. By default, the SID Changer 

searches Windows installations and then changes SIDs in the found Windows instances to automatically 

generated random SID values.  

 

The program provides the ability to change SIDs:  

 

1. Select a hard disk on the Disk Map.  

 

2. Call the Change SID dialog to define appropriate settings. There are several ways to do it: 

  

 Select in the Main menu: Hard Disk > Change SID. 

 Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 

then select the menu item: Change SID. 

  

 
 

3. Generate SID based on BOOT.INI files information. By default, the utility searches for BOOT.INI 

files on all partitions to extract information on Windows installations and then performs modifying of the 

found SIDs by automatically generated random values.  

 

The user can specify some definite directories for search in addition to ones set in BOOT.INI files, or inhibit 

analyzing BOOT.INI files at all. It is also possible to set a SID value manually. 

  

 

The SID changer utility can be applied only to NT and Win2k installations.  

  

Some features may be unavailable in the version of the product you have. To learn more 

about it please consult the Partition Manager Editions chapter. 

Test Surface 

The program allows performing additional surface tests on existing partitions and blocks of free space.  

 

In order to start the surface test the user should take the following steps: 
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1. Select a partition or a block of free space on the Disk Map.  

 

2. Call the Test Surface dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Test Surface… 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Test Surface… 

 

 
 

Surface test level. Choose the level of the test procedure. 

 

3. The operation will be performed immediately after confirmation. 

Check File System Integrity 

The program can check the file system integrity on existing partitions. This function can be used for 

detecting file system errors before performing operations on a partition. 

 

Most useful operations require the targeted partition to have a valid file system to be processed. 

 

In order to start the system integrity check the user should take the following steps: 

 

1. Select a partition on the Disk Map or on the List of Partitions.  

 

2. Call the Check File System Integrity dialog to define appropriate settings. There are several ways to do it: 

 

 Select in the Main menu: Partition > Check File System Integrity. 

 Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 

on the List of Partitions, then select the menu item: Check File System Integrity. 

 

3. The operation will be performed immediately after confirmation. 

Edit/View Sectors 

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard 

disks providing the possibility to directly access and modify sectors, save and restore sectors from specified 

files, navigate through the system metadata, etc. 

 

In order to start the Edit/View Sectors operation the user should take the following steps: 

 

1. Select a hard disk/partition on the Disk Map or on the List of Partitions.  

 

2. Call the Edit/View Sectors dialog to define appropriate settings. There are several ways to do it: 
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 Click the Disk View tab and then choose Disk Editor. 

 Select in the Main menu: Partition/Hard Disk > Edit/View Sectors. 

 Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk 

Map or on the List of Partitions, then select the menu item: Edit/View Sectors. 

 

 
 

 
Careless use of the Edit Sectors function may result in the irreversible data corruption. 

Send Log Files 

The program allows the user to simplify the procedure of sending support requests to the Paragon Support 

Team. In case of having difficulties with handling the program, the user, with the help of this very function, 

can address the company support engineers and provide them with all the information they need such as disk 

layout, performed operations, etc. in order to tackle the encountered problem. Information of that kind is 

stored in Log files. 

 

In order to start the operation the user should take the following steps:  

 

1. Call the Send Log Files dialog in the Main menu: Tools > Send Log Files 

 

2. Give a detailed description on the encountered problem. 

 



Paragon Partition Manager™ 9.0 123 User Manual 

 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

 
 

By clicking the Send button the built-in mail client will generate a template request with attached 

compressed log files and then send it to the Paragon Support Team. 

Log Files 

Log files are simple textual files that can be opened by any text editor. There are several log files 

automatically generated by the program: 

 

Stubact.log 
Contains in-depth information on parameters and 

performance of all operations carried out by the program 

Pwlog.txt 
Besides brief overview on operations it also contains 

detailed information about the state of all hard disks 

Cdb.log 
Contains low-level information on the CD/DVD devices 

used in the system 

BioNTlog.txt 

or 

Bio95log.txt 

It is an OS-dependent supplementary log file derived from 

Bioxx.dll. It may contain valuable information on Windows 

family operating systems 

 

 

Log files do not contain any confidential information on the operating system settings or the 

user documents. 

 

The Send Log Files function is only available when outgoing mail server (SMTP) and the user 

e-mail address are properly set. To learn more about it please consult the Settings Overview 

chapter. 
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Glossary  

Active partition is a partition from which an x86-based computer starts up. The active partition must be a 

primary partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the 

system volume. 

In the DOS partitioning scheme, only Primary Partitions can be active due to limitations of the standard 

bootstrap. 

 

Backup Image is an archive of the disk, which includes all the on-disk files and service information on the 

disk layout. To restore disks from such an archive means retrieving all informational components of the disk 

(e.g. a hard disk image consists of its partitions, the Partition Table and even bootstrap code). 

 

Bootable Archives are created by adding a special bootable section when the user is backing up the data to 

CD/DVDs. The user is able to restore the data from these archives without having to run the program, but by 

simply booting from these CD/DVDs. 

 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by 

Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. The 

smaller the cluster size, the more efficiently a disk stores information. If no cluster size is specified during 

formatting, Windows picks defaults based on the size of the volume. These defaults are selected to reduce 

the amount of space that is lost and the amount of fragmentation on the volume. A cluster is also called an 

allocation unit. 

 

Extended Partition is a type of partition that you can create only on basic master boot record (MBR) disks. 

Extended partitions are useful if you want to create more than four volumes on a basic MBR disk. Unlike 

primary partitions, you do not format an extended partition with a file system and then assign a drive letter 

to it. Instead, you create one or more logical drives within the extended partition. After you create a logical 

drive, you format it and assign it a drive letter. An MBR disk can have up to four primary partitions, or three 

primary partitions, one extended partition, and multiple logical drives. 

 

File system metadata. The servicing structures of a file system, which contain information about allocating 

files and directories, security information etc, are named file system metadata. File system metadata are 

invisible for users and ordinary applications because accidental modifications of the metadata usually make 

a partition unusable. 

 

Hard disk geometry. Traditionally, the usable space of a hard disk is logically divided into Cylinders, 

Cylinders are divided into Tracks (or Heads), and Tracks are divided into Sectors. 

 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named 

Hard Disk Geometry or C/H/S geometry. 

Tracks and Cylinders are enumerated from "0", while Sectors are enumerated beginning with "1". 

These disk parameters play an essential role in the DOS Partitioning scheme. The alignment of partitions 

takes the parameters of the hard disk geometry into consideration. 

 

Modern hardware uses an advanced scheme for the linear addressing of Sectors, which assumes that all on-

disk sectors are continuously enumerated from “0”. To allow backward compatibility with older standards, 

modern hard disks can additionally emulate C/H/S geometry. 

 

Hidden partitions. The concept of hidden partitions was introduced in the IBM OS/2 Boot Manager. 

Operating systems do not mount "hidden" partitions, which prevents access to their contents. 
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A method of hiding partitions consists in changing the Partition ID value that is saved in an appropriate 

entry of the Partition Table. This is achieved by XOR-ing the Partition ID with the 0x10 hexadecimal value. 

 

This method only works when the set of usable Partition ID values is very limited, since large sets of usable 

Partition IDs can lead to confusing file system types; for example, Ext2 partitions are marked with the 0x83 

Partition ID value. A hidden Ext2 partition would be marked with the 0x93 Partition ID value, which is 

identical with the Amoeba File system Partition ID. 

 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file 

attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is 

similar to a FAT table in a FAT file system. 

 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains 

important information about the disk layout: 

- The partitioning scheme. 

- The starting records of the Partition Table. 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 

 

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes. 

The capacity of the MBR is not sufficient to place sophisticated boot programs. This means that the on-boot 

software uses the entire 0th track of the hard disk in addition to the 0th sector because it is not included in 

any partition. For example, boot managing utilities such as LILO, GRUB and Paragon Boot Manager are 

located in the 0th track. 

 

Partition ID (or File system ID) is the identifier of a file system that is placed in the partition. The partition 

ID is used to quickly detect partitions of supported types. Some of the operating systems rely completely on 

the Partition ID when distinguishing supported partitions, while others again do not.  

The partition ID is saved in appropriate entries of the Partition Table. It takes up only 1 byte of space. 

 

Partition Label (sometimes also referred to as Volume Label) is a small textual field (up to 11 characters) 

that is located in the partition's boot sector. This value is used for notification purposes only. It is detectable 

by any partitioning tool including DOS' FDISK utility. 

 

Modern operating systems use other methods to save the Volume Label within the file system, e.g. as a 

special hidden file. The Volume Label is able to contain a relatively large amount of text in multiple 

languages. In general, the Volume Label and the Partition Label are rather different. 

 

Partitioning scheme is a set of rules, constraints and the format of on-disk structures that keep information 

of the partitions that are located on the hard disk. There are several partitioning schemes, which can be used. 

The most popular partitioning scheme is the so-called DOS partitioning scheme. It was introduced by IBM 

and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible computers. 

 

Another popular partitioning scheme is the so-called LDM (Logical Disks Model) that originates from UNIX 

mainframe systems. The Veritas Executive accommodates the simplified version of LDM to the Windows 

2000 operating system. 

 

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme 

and the new Dynamic Disk Management (DDM). The problem is that older versions of Windows do not 

support DDM. In addition, most hard disk utilities do not support it as well. 

 

Recovery Media is a CD or DVD (or even a floppy disk) from which the user can boot and recover the 

system. 
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Root Directory is the top-level directory of a formatted logical drive. The Root Directory includes other 

files and directories. 

In modern file systems (e.g. Ext2/Ext3, FNTFS and even FAT32), the Root Directory does not differ from 

other directories in properties. This is not the case for old FAT12 and FAT16 file systems. 

 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a Serial Number, 

which consists of 32 bits and is represented by an 8-figure hexadecimal value.  

 

The hard disk's Serial Number is stored in the MBR. Its value is assigned when the MBR sector is initialized 

by standard disk managing tools from Microsoft, such as Windows Disk Administrator and FDISK utility.  

 

In fact, the hard disk's Serial Number is not important for most operating systems and software. It is known 

that Windows NT, 2000 and XP store hard disks’ Serial Number values in the database of assigned drive 

letters. 

 

A partition's Serial Number is stored in its Boot Sector (in FAT16, FAT32 and NFTS file systems). Its value 

is assigned when the partition is formatted. In fact, the partition's Serial Number does not play an important 

role for most operating systems and software. 


